TonyPlot

User’s Manual
The information contained in this document is subject to change without notice.

Silvaco, Inc. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE.

Silvaco, Inc. shall not be held liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

This document contains proprietary information, which is protected by copyright laws of the United States. All rights are reserved. No part of this document may be photocopied, reproduced, or translated into another language without the prior written consent of Silvaco Inc.


All other trademarks mentioned in this manual are the property of their respective owners.

Copyright © 1984 - 2014, Silvaco, Inc.
## How to Read this Manual

<table>
<thead>
<tr>
<th>Style Conventions</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| **•**              | This represents a list of items or terms. | • Bullet A  
• Bullet B  
• Bullet C |
| 1.                 | This represents a set of directions to perform an action. | To open a door:  
1. Unlock the door by inserting the key into keyhole.  
2. Turn key counter-clockwise.  
3. Pull out the key from the keyhole.  
4. Grab the doorknob and turn clockwise and pull. |
| →                 | This represents a sequence of menu options and GUI buttons to perform an action. | **File→Open** |
| Courier           | This represents the commands, parameters, and variables syntax. | **HAPPY BIRTHDAY** |
| **Times Roman Bold** | This represents the menu options and buttons in the GUI. | **File** |
| **New Century Schoolbook Italics** | This represents the variables of equations. | \(x + y = 1\) |
| **Note:**         | This represents the additional important information. | **Note:** Make sure you save often when working on a manual. |
# Table of Contents

## Chapter 1
Introduction .................................................... 6

1.1 What is TonyPlot ........................................... 7
1.1.1 Examining Data ......................................... 7
1.1.2 Online Help ........................................... 8
1.1.3 Terminology ........................................... 8
1.1.4 Standard Controls .................................... 9

## Chapter 2
Using TonyPlot .................................................. 10

2.1 Starting TonyPlot .......................................... 11
2.1.1 Command Line Options ................................ 12
2.1.2 Loading Examples .................................... 12
2.2 The Base Window ......................................... 13
2.2.1 File Menu ........................................... 13
2.2.2 Edit Menu ........................................... 21
2.2.3 Plot Menu ........................................... 47
2.2.4 Tools Menu .......................................... 55
2.2.5 The Production Menu ................................ 70
2.2.6 Help Menu ........................................... 80
2.3 Plot Control ................................................ 82
2.3.1 Plot Selection ........................................ 82
2.3.2 Pointer Zooming .................................... 82
2.3.3 TonyPlot Command Stream ......................... 83
2.3.4 Key Commands ...................................... 90
2.3.5 3D Plot Control .................................... 90
2.4 Key Legends ................................................ 91
2.4.1 Key Types ........................................... 91
2.4.2 Positioning Key Boxes ............................... 91
2.4.3 Drawing Styles ...................................... 92
2.5 Plot Display ................................................ 93
2.5.1 2D Mesh Plot Display ............................... 93
2.5.2 X-Y Graph Display .................................. 102
2.5.3 Cross Section Display .............................. 104
2.5.4 RSM Display ......................................... 106
2.5.5 Statistics Display .................................. 109

## Chapter 3
Data Files ........................................................ 112

3.1 User Data Files .............................................. 113
3.1.1 Loading User Data Files ......................... 113
3.1.2 Creating User Data Files ............................ 113
3.1.3 Data Format ........................................... 113
3.1.4 Examples ............................................. 114
3.2 Set Files ...................................................... 116
### Table of Contents

3.2.1 Creating .......................................................... 116
3.2.2 Loading .......................................................... 116
3.2.3 Setfile Syntax ...................................................... 117

**Chapter 4**

**Overlays** .......................................................... 118

4.1 Overviews .......................................................... 119
  4.1.1 Making An Overlay .............................................. 119
  4.1.2 Splitting An Overlay ........................................... 119
  4.1.3 Overlay Control ................................................ 119
  4.1.4 Overlay Display ................................................ 119
  4.1.5 Identifying Data ............................................... 120
  4.1.6 Level Names ................................................... 120
  4.1.7 Cutlines ....................................................... 120
  4.1.8 Preferences .................................................... 120

**Chapter 5**

**Production Mode** ................................................ 121

5.1 Overview .......................................................... 122
  5.1.1 Enabling Production Mode ..................................... 122
5.2 The Production Mode Dialog Box .................................. 123
  5.2.1 Interactive RSM Control ....................................... 123
  5.2.2 The Input Sliders .............................................. 124
  5.2.3 Failure Analysis ............................................... 124
  5.2.4 Calibration .................................................... 125
  5.2.5 Synthesis ..................................................... 126
  5.2.6 Yield Analysis ................................................ 126
  5.2.7 Input Parameter Ranges ....................................... 127
  5.2.8 Input Distributions .......................................... 128
  5.2.9 SPC Limits ................................................... 128
  5.2.10 Experimental Results ....................................... 129
  5.2.11 Optimizer Setup ............................................. 130
  5.2.12 ASA Setup ................................................... 131

**Appendix A**

TPCS Commands .................................................... 132
  A.1 TPCS Language .................................................. 133
    A.1.1 Syntax ..................................................... 133
    A.1.2 Commands .................................................. 133

**Appendix B**

Models and Algorithms ............................................ 144
  B.1 Introduction ................................................... 145
    B.1.1 Physical Models ............................................ 145
  B.2 Concentration Dependent Mobility ............................. 146
  B.3 Field Dependent Mobility Model ................................ 147
  B.4 Sheet Resistance Calculation .................................. 148
  B.5 Threshold Voltage Calculation ................................ 149
    B.5.1 Breakdown Voltage Calculation .............................. 150
Chapter 1
Introduction
1.1 What is TonyPlot

TonyPlot (version 3) is a graphical post processing tool for use with all Silvaco simulators and is an integral part of the VWF Interactive Tools. TonyPlot can operate stand-alone or along with other VWF Interactive Tools, such as DeckBuild, VWF, or SPDB.

Users of earlier versions of TonyPlot will find some of the functionality familiar. But this version has new some capabilities and a new user interface. The interfaces are easier to use and the resulting display has improved. This version provides:

- Multiple file loading
- Command language control
- Plot comparison and overlay
- Movie function (replaces the Master tool Movie)
- HP4145 emulator
- Process animation
- Cross section profile integration
- Poisson Solver
- Many more user defined preferences
- Improved user interface and ease of use
- Improved cutline definition and creation
- Faster drawing
- New Structure file features
- User definable setup parameters and set files

All the features already available in TonyPlot are still supported in this version.

1.1.1 Examining Data

TonyPlot can be used to examine several data files all at once, each in its own plot window. You can combine these plot windows by “overlaying” the data sets so you can make direct comparisons. Plots can be interactively added, deleted and duplicated, overlaid and separated.

Not only does TonyPlot allows you to display any data file produced by Silvaco tools, it also provides extensive “tools” for examining these plots and the associated data. For example, you can take cut-line slices through 2D structures, integrate a curve to calculate an area, or perform simple electrical simulations on 1D devices.

TonyPlot allows you to rescale, zoom, and pan plots. You can also add grids, customize axes, and draw arbitrary labels on the data. All titles, marks, labels, ranges and so on are automatically set to useful defaults but can all be explicitly set whenever necessary. The appearance of all plots in TonyPlot can be customized. There are many “preferences” that can be tailored to either suit your needs or the requirements to a particular set of data. See Preferences on page 28 for more information.

TonyPlot supports a wide variety of different printers and can be setup to print to any size of paper. TonyPlot can also be used to study the output from Silvaco’s process and device simulators Athena and Atlas. It also plots data from the process database SPDB when used inside the VWF framework. TonyPlot can display regression models, response surfaces, scatter plots, histograms SPC charts, pie charts, and more.
1.1.2 Online Help

You can access TonyPlot’s online user’s manual. If the manual does not answer a particular problem, then contact Silvaco (support@silvaco.com). See Section 2.2.6 Help Menu for more information.

1.1.3 Terminology

The following terminology is used throughout TonyPlot that have certain meanings and relationships. See Table 1-1 explains this terminology.

<table>
<thead>
<tr>
<th>Terms</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>This is the set of data contained within a structure file (e.g., doping, geometry, or biaspoints). One structure usually requires one plot but sometimes two. The same structure can be repeated in many plots.</td>
</tr>
<tr>
<td>Plot</td>
<td>This is one drawing. A plot can be of one or more structures but cannot exist without a structure. Several plots can show the same structure, which allows the data to be simultaneously examined from two different angles. TONYPLOT is capable of displaying three kinds of plots, each with its own distinct preferences: 2D-Mesh plots, Graph plots, and Cross-Section plots.</td>
</tr>
<tr>
<td>Selected Plot</td>
<td>Not all plots need be operated on at once. A subset of plots is defined by selecting required plots. Selected plots are shown by having bold borders. Unselected plots are shown by having dull borders.</td>
</tr>
<tr>
<td>View</td>
<td>This is the collection of plots in the main window. This term refers to all plots, selected or not.</td>
</tr>
<tr>
<td>Subwindow</td>
<td>This is the area where a plot is shown. Each plot has a unique subwindow, and each subwindow can only show one plot. You can modify the arrangement of subwindows within the view.</td>
</tr>
<tr>
<td>Display</td>
<td>Each plot has a display setting, which is the set of parameters that defines how to draw the structures in the plot.</td>
</tr>
</tbody>
</table>
1.1.4 Standard Controls

When using TonyPlot, the standard controls (Figure 1-1) are often referenced and in each case perform the same function. This consistency allows you to use the dialogs more efficiently as you become more familiar with the standard controls.

The following standard controls are available:

- **Load Defaults**: This button appears as an icon showing data flow from a disk to a dialog box. Clicking on causes the current settings on the dialog box to be loaded from the defaults file.

- **Save as Defaults**: This button appears as an icon showing data flow from a dialog box to a disk. Clicking on causes the current settings on the dialog box to be applied first (as if **Apply** were clicked on) and then be saved to a defaults file.

- **Ok**: All dialog boxes have an **Ok** button. An **Ok** button will first apply any settings you changed in the dialog box and then closes the dialog box.

- **Cancel**: Clicking on this button removes the dialog box from the screen. None of the changes made to the dialog box will be applied. Use this button when the dialog box is no longer needed and no further changes are required.

- **Apply**: Almost all dialog boxes have an **Apply** button. This button stores the current settings on the dialog box and usually causes a plot to be updated. Click on this button when satisfied with the items on the dialog box. Clicking **Apply** will leave the dialog box open.
Chapter 2
Using TonyPlot
2.1 Starting TonyPlot

TonyPlot can be started independently from a UNIX or DOS command shell, or from other simulator tools such as DeckBuild or SPDB. In the case of the simulator tools, starting TonyPlot is accomplished by selecting the respective command button. The TonyPlot Base Window (Figure 2-1) appears if files are not immediately loaded when started.

To start TonyPlot at the UNIX or DOS prompt enter:

% tonyplot

This starts TonyPlot with no data file loaded and with all options set to their default values. To load files at the same time TonyPlot starts, just specify the filenames on the command line. TonyPlot figures out the type of file and display the data accordingly.

To change some of the options, there are flags available that can also be given on the command line. All of these flags begin with a dash (e.g., -mono), so do not try to load files that have names starting with a dash.

Some of the option flags are position sensitive. Therefore that in some cases, the option must precede the file name (when present). In other cases, the option must follow the file name. Most of the options, however, are position independent. Some of the options are listed in the following section.
2.1.1 Command Line Options

- **add** is the default load method and tells TonyPlot to stop overlaying files once they are loaded in. This only applies to data files loaded from the command line. Files loaded from the Open Dialog are controlled separately (see Open on page 14).

- **ccd** allows the overlay of results of the DeckBuild `extract max.conc.file` output on 2D mesh plots. This is used in the CCD analysis to determine the potential maximum/minimum.

- **help** prints out a list of all command line options that TonyPlot recognizes.

- **-mtitle <maintitle>** overrides the default plot main title and set it to maintitle instead. Use single quotes around `<maintitle>` if you wish to use spaces. All files loaded so far (all that precede this option on the command line) are affected.

- **-nosort** disables sorting. By default, TonyPlot sorts all 2D mesh files so that the triangles are ordered. This allows faster drawing and draws 3D elevation plots.

- **-nosplash** disables the TonyPlot splash screen.

- **-overlay** instructs TonyPlot to load all files after the overlay flag and overlays them onto the first file loaded before the overlay flag.

This only applies to data files loaded from the command line. Files loaded from the Open Dialog are controlled separately (see Open on page 14).

- **-power10** tells TonyPlot to show all values that are shown on a log scale as a power of 10. By default, TonyPlot shows the power index. This can also be controlled with a property. See Preferences on page 28 for more details.

- **-production** starts TonyPlot in production mode.

- **-set <file>** instructs TonyPlot to load the set filename and restore the display to the condition that TONYPLOT was in when that set file was created. The set file is applied to all files loaded at that point. In other words, all files that preceded this option on the command line. Files given after this option on the command line are not affected.

- **-ttile** is the same as **-mtitle** but sets the subtitle instead of the main title.

The **-da**, **-st** and **-bin** options to TonyPlot are all optional. When TonyPlot loads a file, it automatically converts the format of the data and loads it in. The options override this action, however, if needed. Here are some examples of TonyPlot command line options.

2.1.2 Loading Examples

To load two Spisces log files `temp340.log` and `temp450.log` and display the graphs overlayed in a single plot, type:

```
% tonyplot -overlay temp340.log temp450.log
```

To load a Ssuprem4 structure file called `meshX.str` and set its display to a previous set up stored in `mx.set` and then load a file containing IV data in user data format, type:

```
% tonyplot meshX.str -set mx.set iv.data
```
2.2 The Base Window

The TonyPlot Base Window contains the area where all plots are displayed. When there are no plots to display (e.g., when no files have been loaded), a banner page will appear. Along the top of the Base Window is the main menu bar that has the basic control menus for TonyPlot, and the toolbar that displays icons for commonly used actions. Each of these menus are further explained in the following sections.

2.2.1 File Menu

This menu allows you to access file control operations. These operations consist of loading structures, set file control, a command stream, and exiting from TonyPlot.

![File Menu](image)

Figure 2-2 File Menu
Open

This creates a dialog box (see Figure 2-3) that can be used to load structures. A list shows the current contents of the directory specified at the top of the dialog box. All subdirectories are shown (as folder icons) as all files are matching the specified filter.

![TonyPlot: Open Files](image)

**Figure 2-3  Open Dialog**

To load a file, highlight the filename in the scrolling list (by clicking on it) and either click on the Open button or expr-click on the filename. This creates another plot inside TonyPlot to display that data. To select multiple contiguous files, hold the Shift button while highlighting filenames. To select multiple discontiguous files, hold the CTRL button while highlighting filenames.

Changing Directories

The directory that TonyPlot is currently looking at is shown at the top of the dialog. The directory's contents are shown in the scrolling list below. The buttons to the right of the current directory allow you to change levels in the directory hierarchy.

File Filtering (File Type)

A filter is used for screening irrelevant files and defaults to 

\[*.str, *.log, *.rsm, and *.sta\]

\]to show the common types of files produced by Silvaco simulators and other tools. The choices for this filter are Compressed Files (\[*.gz\]) and All Files (\[*\]).
**Action**

TonyPlot allows you to change the action you wish to take when opening new files. You can choose between Add Plot, Overlay Plot, and Replace Plot. Choosing Add Plot is the default action and will add the files opened as separate plots in TonyPlot. Overlay Plot allows you to overlay a plot onto an already open plot. Replace Plot will replace the currently selected plot with the newly opened plot.

**Open Set Files**

This creates a dialog box (see Figure 2-4) that allows you to load a set file. The set file specifies user applied attributes, such as contour drawing for a given plot.

![Figure 2-4 Open Set Files Dialog](image)
Save As

This creates a dialog box (see Figure 2-5) that can be used to save a plot or to save a plot as a particular graphic type (such as JPG, PNG, or GIF). You can select the format you wish to save by choosing it from the File Type list.

Figure 2-5  Save As Dialog
Save Set Files

This creates a dialog box (see Figure 2-6) that allows you to save a set file. The set file specifies user applied attributes, such as contour drawing for a given plot.

![Figure 2-6 Save Set Files Dialog](image)

Save Series

This allows you to save all currently selected plots as a series of graphical output files, such as `output1.jpg`, `output2.jpg`, `output3.jpg`. This can be useful if you want to import the plots into an animation program. The dialog box contains controls to set the base directory, where all files will be saved, the base filename that all generated files have in common, and a drop down menu to choose the graphical filetype that you wish to save as.

![Figure 2-7 Save Series Dialog](image)
Export

This allows you to create data files from plots. To export data, choose one plot that you wish to write to a file and select Export. The Export dialog box will then appear (see Figure 2-8). You can export some files as Master files (Silvaco format) or in a user data format.

![Export Dialog](Figure 2-8 Export Dialog)

Select the option desired. To name the file to be created, enter a base name and a file extension. One file is created for each overlay level in the plot. For example, if you export a three level plot, the basename is hello, the extension is out, and the following three files will be created.

hello_01.out
hello_02.out
hello_03.out

Some types of conversion are not allowed. If this occurs, TonyPlot warns you that you cannot perform the specified export.

Command Stream

This allows you to enter TonyPlot commands directly into the controlling terminal (on UNIX) or into the console window (on windows). For more information, see Section 2.3.3 TonyPlot Command Stream.

Production Mode

When used with VWF, TonyPlot provides powerful Production Mode capabilities. Once you select this option, these features remain active. You can also activate the Production Mode by using the -production option flag when starting TonyPlot from the UNIX command line.
Page Setup

This allows you to change general printer settings, such as page size, page orientation, margins, and color mode (see Figure 2-9).

![Figure 2-9 Page Setup Dialog](image-url)
Print

This allows you to print (depending on your print preferences, see Print Options on page 43) either the currently selected plots, one per page or all plots on one page. You can print on a large variety of paper sizes at full printer resolution.

![Setup Printer Dialog](image)

**Figure 2-10 Setup Printer Dialog**

Exit

This removes all plots, structures and subwindows, and quits TonyPlot. Before exiting TonyPlot, it will ask you to confirm it.
2.2.2 Edit Menu

The Edit menu provides control over the current view using operations that affect groups of plots as described below. Some items on this menu may be inactive (grayed out). This occurs when the operation is not applicable to the current group of selected plots.

![Edit Menu](image)

**Select All**

This provides an easy way to apply an operation to all plots in the view. All plots become selected regardless of their previous state. This item is only active when one or more plots are loaded.

**Swap Two Plots**

This allows you to change the ordering of plots in the view by swapping the positions of any two selected plots.

**Redraw All Plots**

This updates the view and refreshes all windows.

**Make Overlay**

Overlay plots are comprised of several structures drawn in one subwindow. They are created by selecting a group of plots in the current view and then choosing this item. A new plot is created with the structures overlayed. One of TonyPlot’s preferences controls whether the original plots remain intact or are deleted. This item is only active when at least two plots are selected. See Chapter 4 Overlays for a more detailed description.

**Split Overlay**

This breaks an overlay plot up into separate single-level plots. This option is only active when at least one overlay plot is selected.
The Base Window Using TonyPlot

Plot Difference
This requires you to have at least two compatible plots selected. When chosen, this option will create a new plot of the differences in the selected plots.

Duplicate Selected
This duplicates all selected plots. For each one, a new window is created and the structure is drawn in the new window and the original window.

Delete Selected
This removes plots from the view. All selected plots are deleted. This option is only active when at least one plot is selected.

Materials
This allows you to customize the colors of materials. It also controls whether a particular material is shown on keys. The colors used by TonyPlot to represent the different types of materials that can be altered. To change the colors, select Edit→Materials and the Materials dialog box will appear.

Figure 2-12 Materials Dialog
- Name list: The scrolling list shows a list of all material names known to TonyPlot.
- Name: This is the name of the selected material. This cannot be changed.
- **Color**: A palette shows the color currently used for the selected material. Any color can be chosen if the default is not acceptable.
- **Off/On key**: Sometimes you may want to show a certain material on a material key legend. If this is the case, choose the **Off** key.

**Note**: TonyPlot automatically saves the colors you set for the materials. To reset the colors to their default settings, press **Reset Colors to Default**.

**Functions**

Functions allow you to further customize the output that can be produced and to extend the amount of data that can be plotted without needing further simulation runs and large data files. TonyPlot allows you to create functions for use with any type of plot. It also uses an advanced mathematical parser to calculate function results from arbitrarily complex math expressions.

![Functions Dialog](image)

*Figure 2-13 Functions Dialog*
Use Of Functions

In order to use functions, first define a function, in terms of quantity names (e.g., Boron, Drain bias, and Temperature), constants, and operators (sin, sqrt, +, — etc). Then, plot that function in the desired plot. Using scientific notation in functions (e.g., le23) requires the mantissa to have a decimal point (e.g., 1.0e23), otherwise it does not work.

The Functions dialog box can be displayed from the main Edit menu. It can also be displayed from the buttons marked Functions... that appear on each of the three types of Display dialog box.

Once defined, a function is plotted by choosing the name of the function (Function 1 or Function 2) from the relevant control item on the Display dialog box.

Defining Functions

The Functions dialog box is split into two sections. The top section allows function macros to be set up. The lower section is where the functions are actually defined. You can define two types of functions.

- **Graph functions**: These are used on XY Graph plots only and are defined in terms of graph (electrical) quantities.

- **Impurity functions**: These functions can be used in Mesh plots and Cross Section plots only and are defined in terms of impurities.

Two of each type of function is supplied and either or both can be shown on any plot. It is possible to nest functions by including the name of one function as a variable in another.

Plotting

When choosing Function 1 or Function 2, TonyPlot evaluates the results of the function at each data point and stores these values in the data attached to each plot level. Then, the function can be drawn along with any other quantity also selected.

Example

Suppose a Master file contains values for the four dopant impurities boron, arsenic, phosphorus and antimony. We can use a function to compute the net doping by entering the following as Function 1.

boron — arsenic — phosphorus — antimony

Most plots of net doping, however, are shown on log scales (this is the default for TonyPlot) so you need to calculate the log of this sum. Make sure the total is positive beforehand, so use abs() to get the absolute value:

log10 (abs (boron — arsenic — phosphorus — antimony))

The data for each dopant, however, is not useful below values of around 1e12. TonyPlot usually does not show values below this level. But with a function, it cannot tell that this is needed. Therefore, use the MAX() operator to keep the function result within a useful range:

max (log10 (abs (boron — arsenic — phosphorus — antimony)), 12)

Simplify this expression by splitting into two functions and nesting one inside the other, as follows:

Function 1 = boron — arsenic — phosphorus — antimony

Function 2 = max (log10 (abs (Function 1)), 12)
Now plot **Function 2** on a Mesh or Cross Section plot. It will show the profile of **Net Doping** (clipped at 1e12).

**Function Macros**

To allow further simplification of functions, the macro section is provided on the Functions dialog box. It can be used to store common functions and identify them with an easy to remember name. You can use the following options to modify macros.

- **Macro List**: This shows all the macro names currently known to TonyPlot. Select names here to view or edit the macros.
- **Name**: Shows the name of the selected macro and is used to change macro names and add new macros.
- **Definition**: This is a small edit window where the full macro definition is displayed. Use this edit window to enter new definitions.
- **Create**: To create a new macro, enter a new name and definition for the macro, and click on this button. The new name appears in the list. If the name already exists, the old definition is replaced.
- **Delete**: This deletes the macro that is currently selected in the name list.
- **Replace**: This can be used to change a macro name or definition or both. Enter the new text and click on this button to replace the selected macro.

The macro names can then be used in any function as though the whole definition had been typed.

For example, in the **Net doping** example, we could add a macro called `net_dop` and in the definition window, enter:

```
max (log10 (abs (boron — arsenic — phosphorus — antimony)), 12)
```

Then, we could define either **Impurity Function** to simply be `net_dop`.

This makes the function definitions easier to read and allows useful names to be added to the plot key. The Property called **Function label** can be used to change how functions are labelled on the plot key.

All macros can be saved to a defaults file for use any time TonyPlot is used. Two buttons on the dialog box allow defaults to be saved and loaded at any time.

**Function Syntax**

Functions are constructed just like normal math expressions, but with names of quantities from data files used as variable names. Functions can be built with the following operators:

- Normal operator precedence is obeyed.
- Expressions can use parentheses to change the operator precedence where needed.

If an expression contains an error, this is reported when the function is plotted. Invalid values are for the most part plotted as zero, except for `log()`, which uses the value predefined in the Property called **Log Zero**. If a function does contain an error, TonyPlot displays a notice box informing you of the type of error encountered. A syntax error causes all function values to be zero. An evaluation error causes just the offending data points to be zero.

```
a + b a plus b
a — b a minus b
a / b a divided by b
```
The derivative function dydx can take any two variables. It also accepts distance to represent the x value. For example, a vertical cutline dydx(boron, distance) would give the derivative of boron concentration against depth.

**Functions In TPCS**

If you’re unfamiliar with TPCS, see Section 2.3.3 TonyPlot Command Stream.

Expressions can be evaluated in TPCS. TPCS, however, does not perform the variable substitution the functions perform. To evaluate an expression in TPCS, use the following command:

`TPCS> eval <expression>`

where `<expression>` is constructed according to the syntax rules explained above. The result is printed out below the input. For example:

`TPCS> eval log10 (sqrt(sin(0.4)))`

`-0.204792`

`TPCS>`

When TonyPlot plots functions, it uses TPCS commands such as these to work out the new values. Therefore, you can use this to check for computation, syntax errors, or even for a quick calculator.
Shift Curve

This function gives you the ability to shift one or more curves in an XY Graph plot. You can shift the curve on both the X and Y axes.

Use Of Curve Shifting

The Shift Curve dialog box can be displayed from the main edit menu if you have an XY Graph plot selected in TonyPlot. The Shift Curve dialog is split into 3 parts:

• a curve selection drop down menu,
• a text box for the X axis,
• and a text box for the Y axis.

A simple curve shifting example would be entering \( y + 2 \) into the \( y \) = text box. After pressing Apply, this will result in the selected curve being shifted in the positive Y direction 2 units. You can shift the curve on the X axis by using the \( x \) = text box.
Preferences

TonyPlot has many preferences that you can set. You can alter these preferences to suit your needs. All preferences can be viewed and modified using the Preferences dialog box. To open the dialog box, select Edit → Preferences.

Toolbars

- **Display large icons**: This controls the size of the icons on the toolbar.
- **Display text labels**: This controls whether descriptive text is shown beneath the icons on the toolbar.
- **Display hints**: This controls whether or not tool tips are displayed when you hover the mouse cursor over an icon on the toolbar.
- **Customize**: Clicking this button displays a dialog box that allows you to customize which buttons are currently shown on the toolbar.

![Figure 2-15 Preferences Dialog showing Toolbars](image)
Shortcuts

- **Assign**: This customizes which keyboard shortcuts you use for any menu item. Select the menu item you wish to customize. If there is a shortcut currently assigned to it, it will appear in the **Current Keys** box. Press your new desired shortcut (e.g., Ctrl+A) and it will appear in the **Press new shortcut key** box. It will also tell you if the shortcut is currently being used for another menu item. Press the **Assign** button to assign the new shortcut to the menu item.

- **Remove**: This removes the currently assigned keyboard shortcut from the current menu item.

- **Details**: This gives an overview of all the currently assigned shortcuts.

![Figure 2-16 Preferences Dialog showing Shortcuts](image)
Window Options

- **Layout** selects the style used for laying out subwindows within the view. The first two options represent **Multiple** mode (with either horizontal or vertical preference). The third option is **Palette** mode (where one plot is larger than all the others). The fourth option is **Stacked Window** mode, where you view one plot at a time and can flip between plots using the Plot→Next Page and Plot→Previous Page menu items.

- **Panner Jump** sets the amount of new plot exposed when a zoomed plot is panned with the zoom panner. The fractions shown are fractions of the window size.

![Figure 2-17 Preferences Dialog showing Window Options](image-url)
Drawing Options

- **Grid level**: This controls whether the axis grid is drawn on top of the displayed structures or underneath them. The axis grid is controlled from the Annotation dialog box.

- **Mesh level**: This controls whether the simulation mesh is drawn on top of the displayed structures or underneath them. The simulation mesh is controlled from the Display dialog box for either 2D Mesh plots or XSection plots.

- **Mark frequency**: For line plots, this controls the number of marks or points that are drawn along the curve. 1 draws a mark at each and every data point, while any other value draws marks at the specified frequency.

- **Log axis numbers**: When log axes are displayed on either XSection or XYGraph plots, the way numbers are drawn depending on this item. The number 3 is used as an example.

- **Line widths**: This group of controls sets the thickness of the lines used to draw Graph Lines, Edges (2D Mesh, XSection), Vectors, Cutlines, Junctions, and Mask lines. 1 represents normal thickness, with 2 to 4 representing increasingly thicker lines. Small Font, Medium Font, and Large Font are used to control the font TonyPlot uses when rendering plots at different screen sizes.
Plot Options

- **Duplicate**: When a plot is duplicated, the display settings can be applied to the new plot. This causes the new plot to look identical to the original. If you select Structure Only, it will use a default display setting for the new plot.

- **Plot margins**: This controls the space between the edges of the plot and the edges of the window. These are specified in terms of a percentage of the window dimension (window width for left and right and window height for top and bottom).

- **Minimum doping**: This either displays doping concentrations to their actual minimum values (choose Actual) or to a specified value (choose Clip to) with the value in the text field indicating the minimum value at which doping is clipped.

- **Log. of zero**: When plotting results that involve the logarithm of zero (in any base), TonyPlot uses this predefined number as the result. Zero is used by default.

- **Axis Precision**: When required, the axis ticks are rounded up to the maximum number of digits (Axis Precision) to avoid cluttering the plots.

- **XY plot ratio**: This controls the relative scaling in the X and Y directions of the data. If To Window is chosen the axes scale independently so that the whole window is occupied. If To Data is chosen, the axes scale together so that the aspect ratio of the data is maintained. In this mode, at least one of the axes span the subwindow.

- **Net Doping**: This controls whether the absolute or signed values of the net doping are used in plots (absolute or n/p types).

- **Export Resolution**: This controls the resolution of images saved from the Save As menu item under the File menu. The default is 800x600.

- **Export Compression**: This controls the compression ratio used when saving files using the Save As menu item under the File menu. This only applies to image formats that use compression, such as JPEG.
Figure 2-19 Preference Dialog showing Plot Options
Tool Options

- **Probe Refresh**: This refreshes the probe by removing old probe targets from the plot area.
- **Ruler Readout**: This displays the position of the pointer in the frame footer whenever the rules are being used.
- **Cutline X Axis**: There are three methods for marking the X axis on cutline profiles. By default, the X coordinate is relative to the start of the line, and so measures distance along the line. If you select **Absolute**, the axis shows the X coordinate of the original mesh (if the cutline is horizontal) or the Y coordinate (if the cutline is vertical). Cutlines that are neither horizontal or vertical show a **Relative X axis**. If you select **Interface**, the X axis centers around the first material interface in the cross section. For example, the first interface is at X=0. If no interface exists, a **Relative X axis** will be drawn.
- **Probe Impurities**: This controls how impurity values reported by the **Probe** tool are shown. By default, true linear scale values are shown. Select **Log of value** to see the values on a log scale.
- **Zoom Out Percentage**: This controls how much TonyPlot zooms out when you press zoom out button (🔍) on the main toolbar.
- **Axis Scaling**: This controls which axes scale when you use the variable zoom feature. To use this feature, hold down the Shift key and the right mouse button and drag the mouse to zoom.
Figure 2-20 Preference Dialog showing Tool Options
**Overlays**

- **Creating**: When creating overlays, this item either allows you to leave the original plots in place (choose *Leaves Originals*) or delete them (choose *Deletes Originals*). If you delete the originals, you can retrieve them by splitting the overlay. If they remain, splitting the overlay duplicates the originals.

- **Level colors**: This can show overlay plots each level in the same color (choose *Single*) or use a different color for each (choose *In Sequence*).

- **Number of Levels**: To avoid confusing plots, you can limit the number of levels added to an overlay. Choose *unlimited* to deactivate this feature.

- **Display option**: This allows you to choose whether to use mark types for quantities plotted and color for the level, or to use mark types for the level and color for the quantity.

---

**Figure 2-21 Preference Dialog showing Overlay Options**
General Colors

General colors are colors of items that are not related to any specific data type. Each can be specified independently and set to any color that TonyPlot supports.

- **Window**: The color of the subwindow.
- **Background**: The color of the plot background.
- **Foreground**: The color of the plot foreground.
- **Dark border**: The color of borders on unselected plots.
- **Light border**: The color of borders on selected plots.
- **Zoom**: The color used when dynamically defining areas, lines, and other attributes on the plot. For example, zooming and placing cutlines. The color specified here cannot be the color observed if the color where the lines appear is not the actual **Background** color. This is due to the graphics operation used. If you have problems distinguishing the lines from the color on which they are drawn, changing this color may improve the contrast.
- **Grid**: The color of the axis grid.

![Figure 2-22 Preferences Dialog showing General Colors](image)
**Structure Colors**

Structure colors are colors of items related to specific data items. Each is specified independently and set to any color that TonyPlot supports.

- **Mesh**: The color of the simulation mesh on 2D Mesh plots and Cross Section plots.
- **Edges**: The color of edges on 2D Mesh plots and Cross Section plots.
- **Cutlines**: The color of cutline positions on 2D Mesh plots. The color specified here cannot be the color observed if the color where the line appears is not the actual **Background** color. This is due to the graphics operation used. If you have problems distinguishing the lines from the color on which they are drawn, changing this color may improve the contrast.
- **Depletions**: The color of **Depletion** Edges on 2D Mesh plots.
- **Junctions**: The color of **Junction** on 2D Mesh plots.
- **Electrodes**: The color of hatching used to indicate electrodes on 2D Mesh plots.
- **Outlines**: The color of contour outlines.

![Preferences Dialog Showing Structure Colors](image)

**Figure 2-23  Preferences Dialog Showing Structure Colors**
Sequence Colors

TonyPlot uses sequence colors whenever a group of items are plotted and each needs its own color. Examples are lines on items, such as Graph and Cross Section plots, regions, and levels. The colors used are defined by the list of sequence colors indicated on this dialog box. For example, if the first color is red, the level one is Red, the first cross section profile is Red, region 1 is Red, and so on. If you need more than twelve colors, the color sequence repeats at one.

![Figure 2-24 Preferences Dialog Showing Sequence Colors](image)

Figure 2-24 Preferences Dialog Showing Sequence Colors
Sequence Lines

Graph lines are represented by **Lines** and **Marks**. TonyPlot allows you to change the line type of these graph lines. You can choose among **Solid**, **Dash**, **Dot**, **Dash Dot**, and **Dash Dot Dot**.

![Figure 2-25 Preferences Dialog Showing Sequence Lines](image)

Figure 2-25 Preferences Dialog Showing Sequence Lines
Sequence Marks

Graph lines are represented by Lines and Marks. TonyPlot uses different mark types to represent either quantities or levels. You can define these mark types in this dialog box. The types are: Cross, Circle, Plus, Triangle, Square, and Star. This dialog box also allows you to change the size and width of the marks, from a scale of 1 to 6 in size, and 1 to 3 in width.

Figure 2-26 Preferences Dialog Showing Sequence Marks
Key Options

Each key position item provides eight options. If you select Off, then that key will not be drawn. If you select any of the six specific positions, the key will be drawn in that position in the plot. If the icon with the arrow is displayed, then the key has been positioned by hand and is in none of the six standard locations. For more information, see Section 2.4 Key Legends.

- **Contours**: There are three contour keys: one for each set. There are three items to control each one separately.
- **Regions**: This indicates the color used to distinguish each material region or region parameter in 1D and 2D Mesh plots.
- **Graphs**: The Line key for any graph plot, showing line colors and mark types.
- **Vectors**: The vector key for 2D Mesh plots.
- **Levels**: The level key for overlay plots.
- **Key Type**: This sets the ways the keys or legends are drawn in plots. **Transparent** (the default) allows the key box to show the plot underneath. **Opaque** covers over any part of the plot under the key.
- **Function Label**: This determines whether functions appear on key legends as names (e.g., Function 1) or as their definitions, as shown Figure 2-13.
- **Contours Color Set**: This allows you to choose which palette of colors to use when doing contour drawing.

![Figure 2-27 Preferences Dialog Showing Key Options](image-url)

Figure 2-27 Preferences Dialog Showing Key Options
Print Options

- **Print Plots**: This allows you to choose whether to print selected plots, one plot per page, or all current plots on one page.

![Preferences Dialog Showing Print Options](image)

**Figure 2-28 Preferences Dialog Showing Print Options**
Environment

- **Name of user**: This is your name as known by the operation system when TonyPlot starts. This can be used in titles and footers by using the macro \$NAM.

- **Login name**: This is the login name for the account currently being used. This can be used in titles and footers by using the macro \$USR.

- **Group**: This is the login group name of the account currently being used. This can be used in titles and footers by using the macro \$GRP.

- **Host**: This is the name of the workstation used to run TonyPlot. This cannot be the workstation used to display TonyPlot. This can be used in titles and footers by using the macro \$HST.

- **Company name**: This is the name of your company (if any). This information is not known by TonyPlot, so it is blank by default. This can be used in titles and footers by using the macro \$COM.

- **Project**: This is the name of the project you are currently working on. This information is not initially known by TonyPlot, so it is blank by default. This can be used in titles and footers by using the macro \$PRJ.

![Figure 2-29 Preferences Dialog Showing Environment](image-url)
As mentioned above, some of the environment preferences have an associated macro. For example, your name can be represented with $\text{NAM}$. This macros can be used in titles, labels and footers. Other macros are also available:

- $\text{DAT}$ shows the current date.
- $\text{TIM}$ the current time.
- $\text{PWD}$ the current working directory.

**Miscellaneous**

- **Electrodes Drawn**: When electrodes are drawn in mesh plots, TonyPlot indicates them by using a hashing in the defined color for electrodes. If this property is set to **With names**, then the names of the electrodes (where defined) are also drawn at a point near to the actual electrode region.

- **Min Contour**: This determines whether the minimum contour is displayed as transparent.

- **Default File Filter**: This allows you to change the default file filter used in the Open Dialog box.

- **Mouse Pointer Readout Position**: This allows you to change the precision used for the mouse pointer X/Y coordinates that are displayed in TonyPlot’s status bar.

- **Window Zoom Direction**: This allows you to set which direction you would like to use for the **Window Zoom** tool ($\text{Z}$). You can choose X, Y, or X and Y. The zoom factor may be set in the text box next to the $\text{Z}$ in the TonyPlot toolbar.

- **Sort Quantity**: This allows you to display quantities in dialog boxes such as the Contours Dialog in alphabetical order or unsorted.
Figure 2-30 Preferences Dialog Showing Miscellaneous
2.2.3 Plot Menu

The Plot menu provides control over selected plots. The items on the menu can operate on many selected plots of the same type. If plots of different types are selected, only those with the same type as the first selected plot are affected.

![Plot Menu Table]

Figure 2-31 Plot Menu

Display

This dialog box is used to change how the data is displayed. See Section 2.5 Plot Display for more information.

![Display Dialog]

Figure 2-32 The Display Dialog
Annotation

The Annotation dialog box (Figure 2-33) allows you to specify plot parameters that are independent on the data, which do not fall into the category of display settings. These are features such as titles and axis ranges. The features of a plot that are independent from the type of plot are called annotation features. To access this dialog box, select Plot→Annotation.... The Annotation dialog box works over multiple plots in the same way as the display dialog boxes. The difference is that this dialog box affects all selected plots, regardless of their respective types.

![Annotation Dialog](Figure 2-33 Annotation Dialog)
Titles
Each plot has two titles. TonyPlot assigns these titles by default. You can change them if required. The current main title and current subtitle are displayed in their respective text fields on the dialog box. You can change the titles without having to redraw the plot(s) completely by changing the title and pressing the Apply button. This leaves all other items as is and only the titles are redrawn on the selected set of plots.

Note: If you select Specify, you can change the titles. If Auto is selected, titles cannot be changed. This allows you to change more than one plot with the Annotation dialog box without the titles on all plots ending up the same.

Show
This item controls features that appear around the edge of the plot. The icons represent, from left to right, x-axis ticks and numbers, y-axis ticks and numbers, grid, x axis label, y axis label, and zero lines. The large buttons can be used to invert the plot. For example, reverse the positive and negative directions of the x- or y-axis.

Range
The default ranges on the X and Y axes are calculated to ensure that all of the data from all structures in the plot can be seen. You can change these values. Selecting Specify rather than Auto enables the axis control items, allowing you to enter the minimum and maximum values, as well as the division and number of ticks per division. For axes that are plotted on a log scale, the division is always 1.0 regardless of the value entered manually.

When the axis ranges are specifically set and applied to multiple selected plots, all plots are scaled the same. This allows easy plot comparison of similar data.

Statistics Plots
Some statistics plots do not have the regular range controls as described above. Instead, the controls allow you to enter user-specified “bin values”, which are used when calculating data distributions.

When you select a statistics plot and summon the Annotation plot, the range controls include a choice to allow you to select Auto bins (automatically determined by TonyPlot according to the data range) or to specify the bin values. When you choose Specify, use the min and max text fields to enter the minimum and maximum bin values. Then, enter the Number of bins to be used between these limits. TonyPlot adds each bin value to the scrolling list when you press the Apply button.

Axis Labels
The x axis and y axis labels can be modified. These are only updated on the plot when the Apply button is clicked on. Once an axis label has been set this way, it is always shown, even if the quantity represented on the axis is changed. To return to the normal axis label, erase the user-specified label from this field and click on Apply again.

Note: Cross Section plots generated by the Cutline tool will display an automatic x axis label if none is entered manually. This automatic title is provided by TonyPlot according to the type of cutline x axis desired (see Preferences on page 28).
Footers
Any plot can have footer subtitles in the left or right or both corners. No footers are drawn by default. You can add them with these text fields on this dialog box.

Special Characters and Macros
Titles, axis labels and footers may all contain “special characters” if needed. These allow alternative letters and symbols to be drawn, such as Greek letters, and superscript numbers. The titles and footers may contain “title macros” (see Preferences on page 28).

Labels
Labels are used to add arbitrary notes and informative text to any plot. These labels can be drawn with leader arrows or can be free standing. The Labels dialog box is used to add, change, and delete these labels (see Figure 2-34). To access this dialog box, select Plot→Labels. As with the Annotation dialog box, the Labels dialog box is the same for all plot types. The difference, however, is that only the first selected plot is affected. Each plot has a list of labels associated with it. Each label has a position in the plot to which it belongs. The labels that belong to the selected plot are shown in the list on the Labels dialog box.

Figure 2-34 Labels Dialog
The following describes each of the items on the dialog box.

- **List of labels**: This list contains all the labels that have been defined for the selected plot.
- **Label**: This shows the text of the selected label and is used to enter new text when creating or changing a label.
- **Create**: Clicking on this button creates a new label with the text shown in the **Label** text field. If the field is empty, the new label is created with its text set to **New label**. The label attributes are set from the state of the attribute items (e.g., arrow and size). You can have more than one label with identical text.
- **Replace**: This replaces the selected label with new text or attributes or both. Use to change the label attributes, such as color and size.
- **Delete**: Clicking on this button deletes the label that is selected in the list. The label is removed from the plot if it has been placed.
- **Arrow**: When placing a label with a leader arrow, the leader can be forced to snap to angles of 45°. This is a “constrained” arrow. A “Free” arrow can be drawn at any angle.
- **Direction**: This determines the direction of the text. The normal choice is **Right**, which draws regular text. **Up** and **Down** draw text rotated by 90° upwards or downwards.
- **Size**: This controls the size of the letters in the label. Three sizes are possible: **Small**, **Medium**, and **Large**.
- **Color**: A color palette is provided for selection of the label color. This is used for both the text and the leader line.
Placing Labels

Labels are placed on the selected plot in one of two ways. One, by clicking to place a simple text-only label. Two, by dragging to place a label with leader line (see Figure 2-35).

If a leader label is being placed, the start of the drag is where the text appears and the end of the drag will be the end of leader. In other words, the position to which the leader points. As with any drag operation, holding down the Shift key moves the start and the end points of the drag. When the drag is done, the label text is positioned correctly relative to the direction of the leader line. For example, if the leader points down and to the right, the text will be placed so that the leader starts from the bottom right corner of the text.

If you place a simple text-only label, the cursor indicates how the text is positioned by pointing to a corner. For example, if the cursor points up and right, the text will be placed so that the clicked point is in the bottom left of the text. You can change the cursor to obtain different alignments by pressing the P key on the keyboard. Four positions are available.

To move a label, repeat the placing procedure. The old label is drawn in the current background color as a quick erase operation that does not redraw the whole plot. Once placed correctly, a redraw of the view tidys up the display.

Note: If the first character of a label is a space, then TonyPlot will draw a small “blob” on the end of a leader line. This can be useful in identifying the location to which the label refers.
Special Labels

In some cases, TonyPlot generates labels automatically. If text appears on a plot, it is usually a label, placed by TonyPlot, that can be controlled with the regular label dialog box as explained above. Some examples of special labels are:

- **Integration Tool**: This tool (see Integrate on page 64) adds a label to show the integrated x-range and area. Although placed in a default position, you can customize the label attributes with the Labels dialog box.

- **2D RSM Plots**: Pressing the ‘v’ key in a 2D RSM plot adds a spot height label to the plot. The label can be moved but the height does not change, so the label value would then be invalid.

- **Electrode Names**: 2D Mesh structures from ATHENA or ATLAS can contain electrode information. When electrode names are plotted, they appear as labels. By default, they are positioned over the appropriate electrode but can be moved if desired.
Level Names

This allows you to change the names assigned to overlay plots. Overlay plots use the data file name as a default name for each level. This dialog box also allows you to select whether graph lines have points or lines for individual levels. See Chapter 4 Overviews for details about overlays.

![Figure 2-36 Level Names Dialog](image)

Set Zoom

This displays the Zoom dialog box (Figure 2-37). This dialog box is used to define a data range to which the plot will be zoomed. Enter the opposite corners of a rectangle and click on the Apply button to set this zoom. Any previous zoom parameters will be discarded.

![Figure 2-37 Zoom Dialog](image)

Zoom out

This restores the plot to its normal size.
2.2.4 Tools Menu

As well as displaying information contained in structures, TonyPlot can examine that information in a variety of ways. Each method of examining the data is called a Tool. The Tools menu shows all the tools available. The Tools menu may show some unavailable items. This is because the tool cannot be applied to the current set of selected plots. For example, the HP4145 Emulator tool only works with Graph plots so it is unavailable if no Graph plot exists and is selected. The following provides brief descriptions of the tools.

<table>
<thead>
<tr>
<th>Cutline...</th>
<th>F2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler...</td>
<td>F3</td>
</tr>
<tr>
<td>Probe...</td>
<td>F4</td>
</tr>
<tr>
<td>Movie...</td>
<td>F5</td>
</tr>
<tr>
<td>HP4145...</td>
<td>F6</td>
</tr>
<tr>
<td>Integrate...</td>
<td>F7</td>
</tr>
<tr>
<td>Tracers...</td>
<td>F8</td>
</tr>
<tr>
<td>Poisson Solver...</td>
<td>F9</td>
</tr>
</tbody>
</table>

Figure 2-38 Tools Menu

Cutline

Cross section profiles can be made from two dimensional data sets. Using the Cutline tool generates one dimensional cross section profile plots. The Cutline tool also has the ability to move cutlines through a device and watch the profile move and shift as the cutline position updates. The Cutline tool also allows these sequences to be combined into a Movie. This item is only active when at least one 2D-Mesh plot is selected.

The Cutline tool is used on 2D Mesh plots only. It is used to create 1D cross section plots from arbitrary positions within a 2D structure. The Cutline Tool dialog box (Figure 2-39) consists of the following items:

- **Create**: The top section provides different choices for creating cutlines. These choices are free, vertical, horizontal, chained, interface, and keyboard. Each of these is described below.
- **Select**: The center portion allows you to choose any cutline created for manipulation. This includes shifting and movie making of the cutline.
- **Movie**: The movie section (displayed when the Make movie button is clicked on) is used to make a movie from a cutline by repeatedly moving its position.
- **Shift Position**: You can move a cutline once created by using these controls, which are displayed when you click on this button.
Creating

To create a cutline, select one of the Create options and follow the actions specific to the mode to define the cross-section.

Note: While dragging, holding down the Shift key causes the start point to move as well as the end point.

- **Free**: To define a free cutline, drag the mouse over the source plot to define a line through the mesh. Releasing the mouse button creates the cross section.
- **Vertical**: Same as free but dragging is restricted to a vertical direction. Release the mouse button to create the cross section.
- **Horizontal**: Same as free but dragging is restricted to a horizontal direction. Release the mouse button to create the cross section.
- **Chained**: To create a chained cutline, click on the mouse SELECT button in various places to create a polygon of chain line segments. To erase to last point placed, use the ADJUST button. Press the Return key to create the cross section.
- **Interface**: To create this type of cutline, click on the mouse SELECT button to place two points on any interface (region boundary). Click on ADJUST to erase to last point placed. Press Return to see the portion of the interface along which the cross section is calculated. If the portion is wrong, press to try other routes. When ready to create to cross section, press the Return key once more.
- **Keyboard**: To create a new cutline with exact start and end coordinates, enter the start and end points into the text fields supplied and click on Return. This creates the new cross section from the line so defined.
Creating From Multiple Plots
If you select more than one mesh plot when a creating cutline, a cross section will be calculated for each of them, and will generate the appropriate number of new plots. If you make a cutline from an overlayed mesh plot, the cutline plot generated is also an overlay plot with each level showing the cutline profile from each level in the mesh plot.

Cross Section
The cross section created displays the profile of the quantity that was contoured on the mesh, or shows a default profile if no contours were drawn. You can control this new plot just like any other cross section plot. All the quantities that were present in the mesh are also available in the cross section.

Default titles show the mesh data file from which the cut was made, and show the start and end positions of the line.

Interface cutlines create an overlay plot from a single mesh plot. Each level in the overlay represents profiles from one of the materials present at the interface. For example, an interface cutline taken along an oxide/silicon interface creates an overlay cross section with one level showing profiles in oxide and the other level showing profiles in silicon.

Any other type of cutline produces an overlay cross section if the source plot was an overlay plot. In this case, the new cross section contains one level for each level in the mesh plot. For example, if two meshes alpha and beta are overlaid and a cutline taken, the new cross section plot contains two levels. The first level contains profiles from alpha. The second level shows profiles from beta.

Deleting
To delete a cutline, delete the cross section plot. This removes the cutline from the mesh from which it was created if still present in the view.

Shifting
To shift any created cutline (except interface cutlines), click on the Shift Position button. By using the directional arrows on the Cutline tool dialog box, the cutline position is moved up, down, left or right.

The amount moved is shown in the Delta text fields, which can be modified. To use the shift feature, select the mesh plot that contains the cutline.

Movies
You can create a cutline movie automatically from the Cutline Tool dialog box. It is created simply by moving the cutline position many times and sequencing the resulting cross sections. To create a movie, define the step size and number of steps, and define whether to move the cross section horizontally or vertically. Note that this does not move the actual position of the cutline on the plot as shifting does. To use the movie feature, select the mesh plot that contains the cutline.
Ruler

The **Ruler** tool can be used on any type of plot. It provides coordinate geometry information of any line drawn over a structure. The **Ruler** shows useful data such as length, gradient, and intercepts of a line you defined. To use the **Ruler** (Figure 2-40), select the plots in which measurements are to be taken and choose **Tools** → **Ruler**... This item is only active when at least one plot is selected.

![Figure 2-40 Ruler Dialog](image)

The ruler position is defined by dragging the pointer across the plot to define a box and line. Holding the Shift key down while dragging the pointer moves the start and the end points of the ruler. The Ruler dialog box shows the following information:

- **Start**: The coordinate of the start point of the ruler.
- **End**: The coordinate of the end point of the ruler.
- **Delta**: The vertical and horizontal distances between the start and end points.
- **Intercept**: The intercept point on the X and Y axes. The terms X axis and Y axis refer to the lines y=0 and x=0 respectively, and not the axes along plot edges.
- **Length**: The distance from the start point to the end point.
- **Angle**: The angle of the end point taken from the start point. 0 is towards positive X, -90 is negative Y, +90 towards positive Y, and ±180 is towards negative X.
- **Slope**: The gradient of the ruler line.
- **Inv.Slope**: The inverse gradient (1 / slope).
• **Type**: Two types of ruler are available. The default ruler is called a “temporary” ruler because once the mouse button is released, the lines are removed from the plot (but the values remain displayed in the Tool dialog box). A “permanent” ruler, however, remains in the plot. The temporary ruler lines are drawn in the plot window, and some of the values from the dialog box are also added at relevant places. This permanent ruler remains on the plot until you place the ruler once more. Switching the ruler type back to “temporary” also removes a permanent ruler.

To return to normal use of the plot window, dismiss the Ruler dialog box.

**Probe**

The **Probe** tool can be used to look at structure information in a 2D Mesh. It provides both geometry and impurity data and can be used to find specified structural features. This can be useful for debugging simulator output as well as for general use. To use the **Probe**, select one or more 2D Mesh plots and choose **Tools → Probe...** Click anywhere within a structure to activate the probe. A crosshair marker indicates the last position clicked. Measurements are then displayed in the **Probe** dialog box as shown in Figure 2-41. This item is only active when at least one 2D-Mesh plot is selected.

![Figure 2-41 Probe Dialog](image)

**Figure 2-41** **Probe Dialog**

- **Probe Coordinates**: The panel at the top of the tool dialog box shows the position where the probe was last placed.
- **Geometry Info**: The second panel shows information about the triangle in which the probe was positioned. The internal index is given for the triangle itself and for each of its three vertices. The actual coordinates of the corners are also displayed.
• **Impurity Values**: The list shows the impurities that are present in the data. Before placing the probe, no values are showing. But when you position the probe, the values of each impurity will appear at each triangle vertex. The values shown are the actual values (linear scale). There is a property in TonyPlot that causes the probe to display log values of impurities that are sometimes seen on log scales. See Preferences on page 28 for more information.

• **Find**: This menu allows the probe to work in reverse. Enter the number of the triangle or point to be probed into the appropriate text field and choose the required option from this menu. The triangle is indicated by a brief sequences of flashes, and points are marked by the probe marker moving to the point on the plot. Alternatively, choosing **Obtuse Triangles** highlights all mesh triangles that contain an angle greater than 90°.

**Note:** When used with RSM plots (drawn in the 2D mode only), only the probe coordinates and impurity (i.e., RSM output) value are displayed. There is no mesh information available and the “find” features are not applicable.
Movie

The **Movie** tool allows you to combine a group of plots into an animated sequence, which can be viewed in playback like a slideshow. To create a movie, you must select the slides. To do this, create a group of plots in the main TonyPlot view, select this group, and choose **Movie...**. This item is active when you select at least two plots. You will notice a delay while TonyPlot creates the movie sequence. The messages will then appear in the frame footer indicating progress. When complete, the Movie dialog box (Figure 2-42) appears, showing the first frame of the movie and a group of control items.

![Tonyplot: Movie](Image)

**Figure 2-42 Movie Dialog**

You can change the size of Movie dialog box. This is explained in Preferences on page 28. The control items are:

- **Video controls**: The five play buttons perform the following functions: rewind to first frame, play backwards, stop at current frame, play forwards, and skip to last frame.
- **Repeat**: This is the item marked with a looping arrow. This repeats playback in an endless cycle in the direction determined by the play button pressed.
- **Speed**: Three playback speeds are available. To see playback speed, select the new speed and press a play button.
- **Export**: This item allows you to export the current movie as an animated GIF.
Note: Only one Movie tool can be displayed at once.

TonyPlot can create automatic movie sequences from cutlines without repetitive use of the \textit{Cutline} and \textit{Movie} tools.

\textbf{HP4145}

The HP4145 Emulator is available for any graph plot. Only one plot, however, can be used with the emulator at any one time. When you select this option (\textit{Tools} \rightarrow \textit{HP4145}), the first selected graph plot changes to mimic the output of the HP4145. A HP4145 dialog box (Figure 2-43) appears containing the controls that resemble the functions of the HP4145.

\begin{figure}[h]
\centering
\includegraphics[width=0.8\textwidth]{fig2-43.png}
\caption{HP4145 Dialog}
\end{figure}
The controls of the HP4145 dialog box are:

- **Cursors**: The control section allows manipulation of cursors represented as plus-sign shaped crosshairs. The buttons allows you to create new cursors, to delete existing ones, to select between existing cursors (the current cursor is shown in bold), and to toggle the size of the current cursor between small and full screen. The four directional buttons move the current cursor. The central button moves the current cursor directly to the marker.

- **Marker**: The marker can be moved along its current graph line by moving the dial. To move the dial counterclockwise, click at the left half of the button. To move the dial clockwise, clicking at the right half of the button. **Skip** moves the marker from one curve to the next, cycling back to the first curve when the last one has been reached.

- **Options**: Several options can be accessed from the middle panel. **Line 1** and **Line 2** toggles a line that joins the marker and cursor. Various geometry information about the lines is displayed on the dialog box and on the key. **Reticule** toggles the plot grid (the same grid that is shown using the Annotation dialog box). **Key** toggles the HP4145 key. **OK** closes the HP4145 emulator and restore the plot to normal.

- **Information**: The lower panel gives position information for the marker and current cursor, and geometry information for both lines.
Integrate

The **Integrate** tool (Figure 2-44) allows you to measure the area under a single plot curve or the area between two curves. The X interval over which the area is calculated can be set by positioning marker lines at certain locations along the X axis. The **Integration** tool works with both **XY Graph** and **Cross Section** plots.

![Integrate Dialog](image)

**Figure 2-44 Integrate Dialog**

**Features Box**

This list shows all the points of interest on the curve in the plot used. It shows all minima and maxima, as well as the start and end X values and positions of all material interfaces. The marker lines, which are used to define the X interval for the integration, can be moved to any of these features, using the arrow buttons or by using the mouse. You can also use the mouse pointer to add more features. See Using the Mouse and Pointer on page 65 for more information.
Options

You can toggle some options when using the Integrate tool. The following options appear in a line under the scrolling list.

- **Draw area** fills the area under/between the curve(s) with a hatched pattern when turned on. If turned off, no area is drawn, but it is still calculated.
- **Absolute value** uses positive areas only, taking the absolute value of all Y axis values. If turned off, areas below the Y=0 line have a negative area.
- **Use log of Y** calculates the area using log values of Y, rather than the true linear value. This option is independent of the method used to draw the Y axis. In other words, you can draw a curve on a log Y-axis scale but calculate the area on a linear scale.
- **Convert X um to cm** converts from microns to centimeters. X axis quantities are sometimes plotted in microns (e.g., cross section plots). Y axis quantities are often given in terms of cm or cm³. Use this option to calculate the area with the X-axis values converted from microns to cm.
- **Results** continually displays the current area and interval on the right.
- **Line control** positions the two lines that specify the interval used for area calculation. These lines can be moved with the buttons marked with left and right arrows. The lines can be placed at any of the features that are shown in the list. You can move a line directly to any feature by choosing either *Move RED line to selected* or *Move BLUE line to selected* from the list. This causes the appropriate line to move to the feature currently selected in the list.
- **Add Label** creates a label in the plot with the integral information. Pressing the button multiple times updates the label with the latest **Real** and **Interval** values.

Using the Mouse and Pointer

The mouse pointer can be used to move either of the marker lines, and to add new features at any point along the X-axis. To move a line, click the SELECT mouse button anywhere near one of the lines and drag the mouse. The line moves to the feature nearest to pointers position. This method allows you to “pick up” a line, move it to a new position, and put it back down. You can also create new features.

To do this, hold down the Shift key and repeat the procedure above. This time, the marker line can be moved to any x location. When you release the mouse button, add a new feature at the current line position and move the line to it.
Tracers

Tracers are used to illustrate the path of vector fields within 2D Mesh structures. They are drawn as small markers, which can be positioned anywhere inside a vector field, and are then animated by TonyPlot to show field strength and direction. The Tracers dialog box (Figure 2-45) is used to control the positioning and animation of the markers.

Figure 2-45  Tracers Dialog

- **Quantity**: This selects the vector quantity that the tracers should follow. These are the same quantities that are shown on the Vectors dialog box (accessed from the Plot Display dialog box), but the vectors do not have to be displayed for the tracers to work.
- **Tracers placed**: This indicates the number of tracers that have been placed on the plot, and the number of tracers available.
- **Animation control**: Three video-like controls are provided to control the animation of the markers. These controls do the following: return all markers to their starting points, starts the markers, and stops them at their current positions.
- **Speed**: There are three speeds available for the animation: Slow, Medium, and Fast. To change the speed while the markers are moving, press Speed again.
- **Calculate**: When you have placed all the markers you wish to animate, click on the Calculate button. TonyPlot then traces out the path of each marker. Progress is reported in the lower left corner of the main TonyPlot frame. When all the paths have been calculated, the markers can be animated. Markers can be placed anywhere within a vector field by clicking at the position where you want a marker to start. The counter on the dialog box indicates how many have been placed. To remove a marker, press the Shift button and click near to the marker to remove. The one nearest the pointer is erased, and if its path has been drawn that too is erased.
- **Setup...**: Press this button to see the small panel of setup options available in the Tracers tool. See the following section.
Setup

Clicking on the Setup... button to reveal the options panel on the Tracer tool dialog box

- **Color**: All markers placed use the currently selected color. Different markers can have different colors by changing the color for each marker placed. Tracer path lines are drawn in the same color as the marker that follows it.

- **Max. jump**: This value controls the “granularity” of the path calculation. Higher numbers reduce the calculation time, but give only approximate paths with long jumps. Smaller numbers produce more accurate paths, but take longer to calculate.

- **Lines**: When turned on, lines are drawn along the tracer paths as the paths are calculated. If turned off, the path is not shown but the tracers still follows the same route.

- **Cycle**: Three cycle modes are available which control the action of markers when they reach the ends of their paths. The first choice stops all tracers as soon as one tracer reached the end. The second choice stops each marker as it reaches the end of its own path. The third choice makes each tracer move in a loop, returning to its start point each time it reaches the end.

Poisson Solver

The Poisson Solver (see Figure 2-46) performs an electrical simulation with the 1D structure, and calculate profiles for a set of electrical quantities.

![Poisson Solver Dialog](image)
The following controls are available:

- **Layers and biases**: The Poisson Solver dialog box shows a scrolling list of all electrical layers within a structure. The layers are areas of the same material. Silicon areas are divided up into n-type and p-type silicon. Along with each layer is shown a bias (in Volts), which is applied to that layer, when the solver is used.

- **Marker control**: The left and right buttons can be used to move the marker arrow from one layer to the next. The marker arrow is used to select layers for applying an external bias (see Applying A Bias To A Layer on page 68).

- **Setup...**: Click on this button to open the Poisson Solver options panel. These options control the solver (see Setup Panel on page 69).

- **Solve**: Click on this button to perform the simulation with the current options and biases.

When the solution is complete, a plot of potential is displayed. Other solutions can be plotted by using the **Plot display** dialog box. The following list of quantities solved is:

- Electron QFL
- Hole QFL
- Electron density
- Hole density
- Intrinsic conc. (nio)
- Potential
- Electron (e-) Mobility
- Hole (h+) Mobility
- Electric Field
- Electrical Conductivity

The Poisson Solver tool provides a built-in 1D electrical solver, which can be used to perform basic simulations of 1D structures. When it is used, the display of the first selected 1D plot shows all electrical “layers” in the structure and one profile (usually “net doping”). An arrow is drawn at the first layer.

**Applying A Bias To A Layer**

To apply an external bias to any layer, move the marker to any layer that is not an insulator. This can be done either with the left and right buttons on the dialog box, or by using the mouse pointer to “drag” the arrow into a layer.

The current layer is selected in the scrolling list on the dialog box. The bias can then be specified by typing the value into the field marked **Bias** on the dialog box. Press **Return** to update the list. For p-type silicon, the bias is converted to a negative value automatically, and to a positive value for n-type. When you set all the desired biases, initiate the solver by clicking on the **Solve** button.
**Setup Panel**

To access Poisson Solver Setup panel, click on the **Setup...** button on the **Poisson Solver** dialog box. The following controls are available:

- **Display Solved Quantities**: This list shows all the quantities that the solver calculates. Only the ones selected, however, are displayed when the solution is complete. All other quantities can be accessed later from the **Plot Display** dialog box. If other quantities are to be displayed automatically, choose them here. More than one can be selected. This does not affect which quantities are calculated, only the ones that are displayed by default.
- **Temperature**: This specifies the temperature to be used for the simulation or use the automatic default.
- **FE Mobility**: This activates the field effect mobility option for the simulation.
- **Work function**: Enter a specific workfunction with this option or use the default value.
- **SOI Device**: This simulates a device with Silicon On Insulator (SOI) structure layers.
2.2.5 The Production Menu

This menu becomes available when you use TonyPlot with VWF and you enable the Production Mode. It contains two groups of options. The first group is a list of all the main Production Mode features. The second group allows direct access to some parameter editing dialog boxes used in Production Mode. See Chapter 5 Production Mode for a full description of these advanced topics.

**Interactive**

This allows interactive user control over regression model parameters to study the effects on the response surface.

![VWF Production Mode Dialog showing Interactive](image)

*Figure 2-47 VWF Production Mode Dialog showing Interactive*
Failure Analysis

This predicts the most likely cause of failure in a production situation, given the characteristics of the input parameters and the failed condition.

![Tonyplot: VWF Production Mode](image)

**Figure 2-48** VWF Production Mode Dialog with Failure Analysis selected
**Calibration**

The Calibration Tool is used to calibrate model parameters. This tool will vary model parameters to best fit a set of measured data points.

![Figure 2-49 VWF Production Mode Dialog with Calibration selected](image-url)

---

**Figure 2-49** VWF Production Mode Dialog with Calibration selected
Synthesis

After a set of outputs required from a production environment is given, this feature calculates the best set of inputs that should be used to achieve that goal.

Figure 2-50  VWF Production Mode Dialog with Synthesis selected
Yield Analysis

This can predict the characteristics of output yield from a production situation from known experimental data of the following input parameters. The following options in this dialog box (see Figure 2-51) provide access to the various parameter editing dialog boxes that are used.

![Image: VWF Production Mode Dialog with Yield Analysis selected]

**Figure 2-51** VWF Production Mode Dialog with Yield Analysis selected

Production Mode

These are same options from the main VWF Production Mode Dialog.
Input Parameter Ranges

As RSM data is loaded into TonyPlot, a record is kept of the greatest range of each input parameter. Along with these minimum and maximum values, a “nominal” value is stored, which represents the normal, or default, value of that input.

You can change the range or nominal value or both of any input by using the Input Parameter Ranges dialog box (Figure 2-52).

![Input Parameter Ranges Dialog](image)

**Figure 2-52** VWF Production Mode showing the Input Ranges Dialog
Input distributions

As RSMs are loaded into TonyPlot, a default distribution is assigned to each one. This distribution represents the statistical “spread” of values that would be obtained for this input parameter in an experimental situation. Using this data, TonyPlot can simulate real-life input values by sampling data with the given distribution parameters.

The default distribution given to each input is Gaussian with a mean value halfway between the minimum and maximum value of that input. The standard deviation will be 10% of the mean.

To alter the distributions for any input, use the Input Distribution dialog box (Figure 2-53).
SPC limits

Each output parameter used in Production mode has a set of Statistical Process Control (SPC) parameters, which can be used to monitor the value of some measured value. There are five SPC limits:

• upper spec limits (maximum values permitted)
• lower spec limits (minimum values permitted)
• upper and lower control limits (ideal maximum)
• lower control limits (ideal minimum)
• center limit (ideal value)

These limits are abbreviated to USL, LSL, UCL, LCL, and CL respectively. Values for each of these are sometimes passed to TonyPlot through the RSM data. If not, or if they need to be modified, the SPC Limits dialog box can be used to add or modify SPC Limit values for any output. To display these values, select Production→SPC Limits and the SPC Limits Dialog will appear (Figure 2-54).

![Figure 2-54 VWF Production Mode showing the SPC Limits Dialog](image)
Experimental Results

Each output parameter modeled by an RSM has an associated experimental value that was measured when the process input parameters used in the model were set to their nominal values. If no experimental value is given for an output, or one needs to be changed, select Production→Experimental Results and the Experimental Results will appear (Figure 2-55).

![Figure 2-55 VWF Production Mode showing the Experimental Results Dialog](image-url)
The Synthesis mode of the Production dialog box provides two synthesis methods. One method is the Levenberg-Marquardt optimizer, and the other method is Adaptive Simulated Annealing (ASA). The parameters for the Levenberg-Marquardt optimizer can be changed in the Optimizer Setup dialog box (Figure 2-56).

![Optimizer Setup](image)

**Figure 2-56 VWF Production Mode with Optimizer Setup selected**
ASA Setup

The **Synthesis** mode of the Production dialog box provides two synthesis methods. One method is the Levenberg-Marquardt optimizer, and the other method is Adaptive Simulated Annealing (ASA). The parameters for Adaptive Simulated Annealing (ASA) can be changed in the ASA Setup dialog box (Figure 2-57).

![ASA Setup Dialog Box](image)

**Figure 2-57** VWF Production Mode with ASA Setup selected

### 2.2.6 Help Menu

The **Help** menu provides access to the online assistance available in TonyPlot.

![Help Menu](image)

**Figure 2-58** Help Menu

**TonyPlot Help**

This shows the latest TonyPlot user’s manual in PDF format.
About

This shows a dialog box notice displaying the version number of the program and its component libraries.

![About Dialog](image)

**Figure 2-59** About Dialog
2.3 Plot Control

Each plot has an associated group of parameters, collectively known as a display setting, that determine how to draw the plot in its subwindow. These parameters are independent from the structure(s) that are represented in the plot, so you can apply them to a number of other structures to make data comparison easier. A plot is controlled using a combination of the following techniques.

- Plot Selection
- Pointer Zooming
- Key Commands
- Command Stream
- Plot Menu

2.3.1 Plot Selection

To control plots and change their display parameters, select one or more plots. When the view consists of only one plot, it is always selected. When the view consists of multiple plots, you must select those to be used. To selection a plot, use either the mouse SELECT button (to select just one plot) or ADJUST button (to toggle the selection state of the plot). Also, selecting the Edit→Select All Plots sets all plots to a selected state.

Plots that are currently selected have a highlighted border, while the border on unselected plots remain normal. The defaults for these colors are white and gray, but can be changed from the General Colors category of the Preferences dialog box.

2.3.2 Pointer Zooming

To zoom in on a specific portion of a plot, you can use a method known as pointer zooming. By dragging the pointer across the plot, a dynamic box can be drawn around the area of interest. If the you hold down the Shift key while dragging the mouse, you can also move the start point of the rectangle.

When you release the mouse button, the plot will be redrawn so that the area within the box fills the whole subwindow.

**Note:** All selected plots of the same type are zoomed in by the same relative coordinate of the zoom rectangle.

When you zoom at least one plot, the Zoom Panner will appear (Figure 2-60). The panner consists of nine buttons: eight directional and a central Zoom Out button. Press the directional buttons to pan around the plot at the same zoom scale. Press the central diamond to zoom out, and restore the plots to their original sizes.

**Note:** You can also perform zooming by specifying the exact coordinates of a zoom rectangle. To do this, use the Zoom dialog box by choosing Plot→Set Zoom....
2.3.3 TonyPlot Command Stream

TonyPlot supports an input language that is used to control the behavior of the program by using text commands only. This language is called the TonyPlot Command Stream (TPCS). See Appendix A TPCS Commands for more information. TPCS is used in set files (see Section 3.2 Set Files). If you examine a set file, it contains TPCS statements. These statements are read by TonyPlot and executed to set the plot display to its state when the set file was created.

There is a close link between TPCS and the TonyPlot Graphical User Interface (GUI). Many statements directly reflect actions you perform on the dialog boxes (such as the apply statements) and plots (the select statements).

To start a command stream, select File→Command Stream. The TPCS prompt will appear in the window where TonyPlot was started (or created on Windows). The prompt looks like this:

```
TPCS>
```

and indicates that TonyPlot is waiting for commands. At the same time, you can use the normal GUI to control TonyPlot.

Syntax

The complete syntax for TPCS is given here. Note that these statements appear in no special order and no complete explanations are given. To get a better understanding of TPCS, you can study set files or contact Silvaco support. The following meta notations are used in the syntax descriptions:

- `<int>`: Any integer (e.g., 4).
- `<string>`: Any word(s) enclosed in quotes (e.g., "my world").
- `|`: Indicates a choice of possibilities each separated by the vertical bar symbol (e.g., on|off is either on or off).
- `<expr>`: A floating point number or a mathematical expression that evaluates to a floating point number (e.g., 3.4, 1.3e12, sin(0.1), and 4+8/3).

The syntax of the command language is tightly linked to the dialog boxes and their controls. Each statement mimics an item on a dialog box or an input action. When using a command stream, you should be aware of the following:

- Plots must be selected when using the commands stream just like when using the normal GUI. To do this, use the Select command.
- Changes are never seen until a Redraw statement is given. This is like clicking on an Apply button.
- The command stream can be used at the same time as the normal GUI but only one command stream can be started at one time.
• The contents of “set files” are lines of command stream syntax. Set files are therefore good examples of command stream syntax. Also, set files can be constructed “offline” using command stream syntax.

• When starting Tonyplot from the command shell in UNIX, Tonyplot must be the current foreground process for the command stream to start. If Tonyplot is not the foreground process, it “stops” until you make it the foreground process. This does not apply to loading set files.

To finish a command stream, type "quit" and press the Enter button.

Help
TPCS has a built-in help system. Enter help at the TPCS prompt to get started. Entering help <word>, where <word> is a topic name (enclosed in quotes) gives a list of commands associated with that topic. For example:

TPCS> help "contours"
shows a list of all commands that have something to do with contours.

Finishing TPCS
To end a TPCS session, enter quit and hit the <Enter> key on your keyboard.

TPCS Supported Statements
The following statements are supported in TPCS.

draw <int>
draw all
draw auto
load <string>
load <string>
load <string> overlay
select <int>
select all
select none
delete
duplicate
show mesh on|off
show edges on|off
show materials on|off
show contours on|off
show vectors on|off
show light on|off
show junctions on|off
show electrodes on|off
show threed on|off
show points on|off
show lines on|off
show xaxis on|off
show yaxis on|off
show axes on|off
show grid on|off
show label xaxis on|off
show label yaxis on|off
show spc on|off
show range on|off
show measured on|off
show normal on|off
show probe on|off
contours <int> impurity <string>
contours <int> type lines
contours <int> type fill
contours <int> outline on|off
contours <int> color <int>
contours <int> max auto
contours <int> max <expr>
contours <int> min auto
contours <int> min <expr>
contours <int> nsteps <int>
contours <int> increment <expr>
contours <int> materials all
contours <int> materials <int>
contours <int> materials <string> <int>
contours <int> apply
threed impurity <string>
threed show edges on|off
threed show yaxis grid on|off
threed show xaxis grid on|off
threed show mesh on|off
threed show grid on|off
threed draw color
threed draw light
threed apply

cutline from <expr>, <expr> to <expr>, <expr>

light materials all
light materials <int>
light materials <string> <int>
light style <int>
light function <int>
light color <int>
light maximum <int>

light apply

junctions show none
junctions show junctions
junctions show depletion
junctions contours <expr>
junctions apply

vectors impurity <string>
vectors impurity xaxis <string> yaxis <string>
vectors materials all
vectors materials <int>
vectors materials <string> <int>
vectors maximum <expr>
vectors minimum <expr>
vectors minimum auto
vectors maximum auto
vectors scale <expr>, <expr>
vectors color <int>
vectors apply

xsection impurity none
xsection impurity <string>
xygraph yaxis none
xygraph yaxis <string> log
xygraph yaxis <string> linear
xygraph xaxis <string> log
xygraph xaxis <string> linear
xygraph type <int> convert <int>
xygraph yaxis scale linear
xygraph yaxis scale log
xygraph yaxis scale all
xygraph polar <int> <string>, <string>
xygraph polar show <int> angle <int>
xygraph smith <int> <string>, <string>
xygraph smith show <int> angle <expr>, <expr>
xygraph group <string>
rsm style <int>
rsm increment <int>
rsm xaxis linear <string>
rsm xaxis log <string>
rsm yaxis none
rsm yaxis linear <string>
rsm yaxis log <string>
rsm contours type lines
rsm contours type fill
rsm contours outline on|off
rsm threed style <int>
rsm range <int>
rsm range log
rsm range linear
title main <string>
title main auto
title sub <string>
title sub auto
footer right none
footer left none
footer right <string>
footer left <string>
range yaxis <expr>, <expr> increment <expr>
rangexaxis <expr>, <expr> increment <expr>
range yaxis <expr>, <expr> increment <expr>, <expr>
rangexaxis <expr>, <expr> increment <expr>, <expr>
rangexaxis auto
range yaxis <expr>, <expr> increment <expr>, <expr>
rangexaxis auto
label xaxis <string>
label yaxis <string>
zoom from <expr>, <expr> scale <expr>, <expr>
zoom out
zoom previous
label <string> from <expr>, <expr> color <int> scale <int>
label <string> from <expr>, <expr> color <int> scale <int> to <expr>, <expr>
label <string> auto scale <int>
label <int> at <int> <int>
label <int> angle <int>
label overlay <int> <string>
key electrical at <int>
key electrical at user <expr>, <expr>
key contours <int> at <int>
key contours <int> at user <expr>, <expr>
key regions at <int>
key regions at user <expr>, <expr>
key vectors at <int>
key vectors at user <expr>, <expr>
key overlay at <int>
key overlay at user <expr>, <expr>
color window <int>
color background <int>
color foreground <int>
color dark border <int>
color light border <int>
color zoom <int>
color grid <int>
color mesh <int>
color edges <int>
color cutline <int>
color junctions <int>
color electrodes <int>
color outline <int>
log label <int>
eval <expr>
abs (<expr>)
sign (<expr>)
log (<expr>)
exp (<expr>)
log10 (<expr>)
sqrt (<expr>)
sin (<expr>)
cos (<expr>)
tan (<expr>)
asin (<expr>)
acos (<expr>)
atan (<expr>)
hypot (<expr>, <expr>)
mag (<expr>, <expr>)
sinh (<expr>)
cosh (<expr>)
maximum (<expr>, <expr>)
minimum (<expr>, <expr>)
help
help <string>
quit
app_exit
print <string>
comment
2.3.4 Key Commands

Key commands are available for some plot control. Point at a plot with the mouse and press one of the following keys:

- **d** (duplicate) duplicates the plot just like selecting Edit→Duplicate Selected.
- **g** (grid toggle) turns the axis grid on or off.
- **h** (help) prints out a list of these key commands on the standard output.
- **j** (junk data) prints a list of all “junk data” attached to the plot structures.
- **m** (mean & standard deviation) prints info about statistical data column (statistics plots only).
- **p** (position) displays the current pointer x-y position in a dialog box window.
- **r** (region data) prints all attached region data for all structures in the plot.
- **v** (value label) adds a spot height value label to contour plot (RSM 2D plots only)
- **z** (previous zoom) sets the zoom level to the zoom level previously used.
- **Z** (autozoom) zooms all mesh plots to the quadrant containing the greatest number of mesh points.
- **b** (bias) display bias information for structure from device simulation.

2.3.5 3D Plot Control

3D plots can be rotated and scaled, but cannot be zoomed.

**Rotation**

To rotate a 3D plot, hold down the left mouse button and drag the pointer left and right over the plot. A wire-frame bounding cube will be drawn around the plot and rotates as the mouse is moved. Position this cube to the desired viewing angle, and release the mouse button. The plot is redrawn from the new view point.

**Scaling**

To scale a 3D plot, hold down the Shift key and the left mouse button. Then, drag the pointer up and down over the plot. A wire-frame bounding cube is drawn around the plot and grows or shrinks as the mouse is moved. Scale this cube to the desired size, and release the mouse button. The plot is redrawn at the new size.
2.4 Key Legends

Data is of little use without a key to explain its meaning. TonyPlot uses keys in a variety of situations to explain how the information in a plot is being represented (see Figure 2-27, the Key Options Dialog). Each key is drawn in a default position in a plot that does not overlap with any other key. You can change these default positions, if necessary. You can also drag keys to any location in the window. In an overlay plot, a key applies to all levels, since the data displayed on each level is the same. An overlay plot also has its own “level” key to indicate the different levels in the plot.

2.4.1 Key Types

- **Contours:** This indicates the value range for a given color when using filled contours. This key also indicates the value of a color when using line contours. Up to three of these keys may appear at once, since a 2D plot may contain up to three sets of contours. Contour keys show only whole integer values when the quantity is contoured on a log scale.

- **Regions:** This can be displayed on 2D mesh plots and Cross section plots. The region key shows region-to-color relationships. Usually, the regions are represented by the materials that they are made of and the key shows these materials and their colors.

- **Graphs:** Whenever graph lines are drawn, there is a graph key. This indicates the different quantities shown by each graph line. These appear, for example, in XY-Graph plots and Cross Section plots.

- **Vectors:** This indicates the size of arrows and magnitudes that they represent: largest, smallest, and halfway between. You can judge the magnitude of other arrows by comparing to this key.

- **Levels:** To distinguish data between levels in an overlay plot, a level key appears whenever there is more than one level. These show the level-to-color relationship for that plot. By default, overlay levels are distinguished by the name of the file that was used to create each level. You can change these names to any other name.

2.4.2 Positioning Key Boxes

There are two ways to position key boxes. The first method uses the **Key Options** category of the Preferences dialog box. This shows a list of all the types of keys mentioned above and an icon along side each one showing its default location. There are six possible default locations. Use the choice item or the cycle button or both to choose the desired location.

The default locations are set up in such a way that there are no overlapping keys. When choosing new default locations, be aware of the possibility of overlapping key boxes. The settings can be saved as the default settings to be used between sessions.

The second method is to position key boxes manually. To do this, point to a key box on a selected plot. Then, drag the mouse while holding down the Shift key on the keyboard. This allows you to drag the key box outline to any position in the window. When you release the mouse button, the view will be redrawn with the key in the new position.

The position of the key applies to all plots. The entire view, however, is not be redrawn when a key has been dragged. The other plots show the key in its new position only when they are redrawn.
2.4.3 Drawing Styles

There are some TonyPlot preferences that control how to draw keys. These are described in Preferences on page 28 but are briefly described here.

- **Key type**: This can be transparent or opaque. Transparent keys allows you to see the plot underneath to some extent. Opaque keys overwrite the plot underneath them. Only opaque keys are used in hardcopies.

- **Function label**: When a function is plotted, it can be indicated on the appropriate key with either its name or its definition. For example, if **Function 1** has been set up as log (current/10). If you choose **Name**, the key says **Function 1**. If you choose **Definition**, it says log (current/10).
2.5 Plot Display

Choosing the way data is displayed in a plot is the heart of TonyPlot. Much information can be shown in a plot, and choosing the correct subset of this information is essential if a useful plot is to be drawn. There are three distinct types of plot, each with its own set of display parameters. These are 2D Mesh plots, XY Graph plots, and Cross Section plots. The method used to set up the display for each of these is described in the following sections.

2.5.1 2D Mesh Plot Display

When the 2D Mesh Plot dialog box appears (Figure 2-61), it shows the current display settings for the first selected 2D Mesh plot. When the settings on the display dialog box are applied, all selected 2D Mesh plots are affected. In this way it is easy to apply global changes to similar plots in the view. The dialog box shows the 10 features that can be displayed in 2D Mesh plots.

![Figure 2-61 2-D Mesh Plot Dialog](image)

The icons shown above symbolize (from left to right):

- **Mesh**: The triangular mesh used in the simulation.
- **Edges**: Sides of triangles classified as region edges.
- **Regions**: All material regions in the structure.
- **Contours**: Color plotting of impurity values.
- **Vectors**: Representation of vectored impurities.
- **Light**: Light beam and ray information.
- **Junctions**: Metallurgical junctions in the semiconductor regions.
- **Electrodes**: Regions defined as being electrodes.
• (3D): Adds elevation to a plot so that 3D surface is plotted

• (Lines): Adds lines dates to plots for ionization integrals or Monte Carlo ion implant.

Some of these features have further control dialog boxes, which can be accessed from the Define button. The features that have detailed control are: Regions, Contours, Vectors, Light, Junctions, 3D, and Lines.

Regions
There are a number of ways that TonyPlot can display mesh regions. The Regions dialog box (Figure 2-62), which is accessed by pressing , and then selecting Define→Regions.

Figure 2-62 Regions dialog box

The first choice controls the way in which regions are drawn. The following options are:

- Solid fills the region area with color.
- Lines draws the region outlines only.
- Lines/Points draws the region outlines and marks the points defining the region border.

The second choice determines the parameter used when determining the regions color. The first two options are always available: Material and Region. If you choose Material, the color represents the material of the region (e.g., silicon or oxide) and the region key shows the material names. If you choose Region, then each region has its own unique color and the key shows the name of each region. If the data contains further region information (e.g., workfunction and phase), then these are also available and the key shows the values of these parameters in each region. Any regions that are one-dimensional (e.g., substrate electrodes) are drawn as thick lines, since they do not enclose a complete area.
Contours

Contouring is the most commonly used method for visualizing data on two dimensional meshes. The contouring facilities in TonyPlot provide sufficient control for obtaining any desired plot. Both contour plots and fringe plots (filled contours) are available with material naming and range control to limit the plot to a restricted subset of the data. Each plot can have up to three sets of contours displayed at once. This makes it possible to view more than one quantity simultaneously, either all filled but in different material regions, or all lines over all materials or any other combination. Of course, if all three sets are filled sets and all are plotted over the same materials, only the third set (the last one to be drawn) will be visible. If lines and filled sets are combined, the filled set should come before the line set.

TonyPlot selects a default quantity whenever possible. This allows contours to be plotted without the need to use the Contours dialog box (Figure 2-63).

![Figure 2-63 Contours dialog box](image)
Just select contours from the Mesh Display dialog box, and plot them by clicking on the
Apply button. The Contours dialog box appears if you select contours on the 2D Mesh
dialog box and click on and then selecting Define→Contours. The dialog box is
divided into subsections, as follows:

- **Set number**: This subsection shows which set is currently being edited. Set 2 will only be
  plotted if set 1 is plotted, and set 3 will only be plotted if set 2 is plotted. To plot a set, the
  quantity (see below) must be anything other than None.

- **Quantity**: Choose the quantity to be contoured. If the range items (see below) are set to
  Auto, the corresponding minimum and maximum text fields are updated to show the
  range of the new quantity. If None is selected, the current contour set is not be plotted.
  One of two functions may also be chosen. Functions are defined from the Functions
dialog box (see Figure 2-13).

- **Materials**: The part of the structure on which contours are drawn can be limited to
  regions of a certain material. If no materials are selected in the list, this is treated as all
  being selected (the default). If you do not plot the contours on any material, set the
  Quantity to None (see above).

- **Range**: The group of items on the right part of the dialog box control the range of the data
  through which contours are plotted. The maximum (top item), minimum (middle item),
  and interval or number of steps (bottom item) can be set or left to automatic defaults. The
  default minimum and maximum values are the minimum and maximum values of the data
  in the structure(s). The default number of steps is the same as the number of colors in the
  current color set (see below).

- **Drawing style**: Selecting the pencil creates line contours, while the paintbrush creates
  filled contours (fringe plot). If you plot filled contours, you can add optional outlines by
  selecting the Outline icon, which is to the right of the paintbrush. TonyPlot provides
  several color sets which can be used for contour plotting. If the contour range is
determined by the number of steps (Num: selected), the number updates to match the
  number of colors available in the color set when one is selected.

- **Level widths**: If you set the drawing style to line contour, this option forces overlayed
  plots to use a different line width for each level.

- **Key title**: The key title can either be set automatically by TonyPlot (set to Auto), or
  manually entered to create a custom title (set to Specify). An automatic title consists of
  the name of the quantity plotted, with units if appropriate. A custom title is created by
  entering the desired text into the text fields supplied. This title is used on the contour key
  for this contour set.

- **Functions**: Click on this button to display the Functions dialog box. This dialog box can
  be used to define the functions of the original quantities that can be selected from the
  choice of Quantities.
Vectors

Vectors can be plotted for standard (the default) or user-defined vectorial quantities. TonyPlot automatically detects the standard quantities made of an X component and a Y component. They are shown in the Quantity pulldown menu. To create a vector made of unrelated X and Y quantities, select the Custom option.

Vectors are represented on the plot by arrows. The direction of the arrow shows orientation of the vector. The color or length of the arrow or both shows the magnitude of the vector. The Vectors dialog box (Figure 2-64) will appear if you choose Vectors on the Mesh 2D display dialog box.

![Vectors dialog box](image)

The items on the dialog box are as follows:

- **Components**: This option controls whether to draw standard or user-defined vectorial quantities.
- **Quantity**: All quantities of the structure that are standard vectorial quantities are shown in this pulldown menu. This menu is only active when the Components option is set to Standard. The list of quantities includes the two functions defined in the Functions dialog box. See Functions on page 23 for more information.
- **Component X**: This menu is active only when the Components option is set to Custom. It is used to assign a quantity to the X component of the user-defined vector.
- **Component Y**: This menu is active only when the Components option is set to Custom. It is used to assign a quantity to the Y component of the user-defined vector.
Plot Display Using TonyPlot

98 TonyPlot User’s Manual

• **Materials**: The part of the structure on which vectors are drawn can be limited to regions of a certain material. If no materials are selected in the list, then it is treated as all being selected (the default). If you do not plot the vectors in any materials, set the **Quantity** or **Component X/Y** to **None**.

• **Range**: The range items on the right hand side of the dialog box control the sizes of the vector arrows drawn. The longest arrow matches the vector with the greatest magnitude, and the shortest arrow matches the smallest magnitude. If the smaller length is specified as zero, then the lengths of the draw arrow are directly proportional to the vector magnitude.

• **Colors**: This specifies the color sets for the arrows. These are the same color sets that are used on the Contours dialog box.

• **Functions**: This displays the Functions dialog box used to define the two functions you can select in the **Quantity** pulldown menu.

**Light Rays**

If a structure contains light ray information, the **Light** dialog box can be used to display that data in a number of ways. Light information consists of a number of **Beams**, and each beam is comprised of a series of **Rays**. A ray is a section of a beam between reflections and refractions. For example, if a beam originates from outside a structure, enters the structure (is refracted), travels to the bottom of the structure (gets reflected), and then moves back to the top of the structure, it consists of three rays. The **Light** dialog box (Figure 2-65) appears if you choose **Light** on the 2D Mesh plot dialog box.

![Figure 2-65 Light Rays dialog box](image)

**Figure 2-65 Light Rays dialog box**
The items in the dialog box are:

- **Beam**: When beams are present in the structure, they are shown as selectable numbers on this item. Any of the beams can be shown at once by selecting the required beam numbers. If no light information is present in the structure, the option **None** is shown to show that there are no beams.

- **Materials**: The part of the structure on which light beams are drawn can be limited to regions of a certain material. If no materials are selected in the list, this is treated as all being selected (the default). If the beams should not be plotted on any material, deselect all beam numbers.

- **Show as**: There are two ways to show light beams. One way as lines that show the path of the beam. Another way solid areas that also show the width of the beam. Choose the required option with this item.

- **Color function**: The light beam rays can be colored in a variety of ways. **Wavelength** colors the rays to match the wavelength. Wavelengths less than ultra-violet are shown as magenta and those above infra-red as pink. **Power** assigns a color from the chosen color set dependent on the beam intensity. **Beam number** assigns one color to each beam. **Reflection Index** assigns the color of a ray according to the number of times it has been reflected.

- **Colors**: This allows you to choose a color set. These are the same as those available on the **Contour** and **Vector** dialog boxes.

- **Maximum reflection**: This can be used to limit the number of rays drawn. Only rays that have been reflected a number of times equal to or less than the number shown are drawn.

**Junction**

You can plot depletion region edges from device simulations (**Figure 2-66**) and metallurgical junctions. Depletion factor is the value of the ratio of majority carriers to doping used to determine the depletion region edge.

![Junctions dialog box](image)
3D

A structure that can be contoured can also be elevated by choosing the 3D option and defining some parameters in this dialog box.

Figure 2-67 3D dialog box

- **Elevation**: Any quantity can be chosen as the elevation. The height of the surface at any point is proportional to the value of the elevation quantity.
- **Show**: There are number of optional items that can be drawn on a 3D plot, and each is described by a small icon on the Show item. Choose the ones desired from this list.
- **View**: The view projection can be one of two choices: **Parallel** or **Perspective**.
- **Log**: You can select whether to log each of the axes individually.
Lines

You can overlay lines onto a 2D plot using the Lines dialog box (Figure 2-68). This is used to show static field lines on ion implant tracks.

Figure 2-68  Lines dialog box

• **Drawing Style:** If you select , TonyPlot will simply draw lines using the range of colors selected in the **Line/Contour Colors** drop down menu. If you select , TonyPlot will draw pseudo contours between the lines. If you select while the paint brush button is selected, TonyPlot will draw lines and contours.
2.5.2 X-Y Graph Display

The Graph Plot dialog box (see Figure 2-69) shows the current display settings for the first selected graph plot. When the settings on the display dialog box are applied, all selected graph plots are affected. This permits much easier application of global changes to similar plots in the view. The Graph Plot dialog box contains all the controls needed for complete control of graph plots.

![Graph Plot dialog box](image)

**Figure 2-69 Graph Plot dialog box**

- **Show**: This allows you to select (Points/Lines) the way lines are drawn on the graph.
- **Type**: This specifies the type of graph that is to be drawn. The options represent cartesian graphs, polar plots, and Smith charts. The data that is plotted is mapped onto axes of the chosen type. If the data is in a format that matches the type chosen (e.g., [r, theta] pairs for polar plots), then selecting the Convert Data button tells TonyPlot to transform the coordinates before plotting them.
- **Functions**: This displays the Functions dialog box, which can be used to define the functions that can be selected from the choice of Quantities. Functions can be plotted on any axis. The type of graph chosen will affect the controls on the remainder of the XY Graph Display dialog box.
Cartesian Graphs

Scales
Since only one quantity can be plotted on the x-axis, there is an item to select a linear or log (base 10) x-axis. Choose the one desired. For the y-axis, more than one quantity can be plotted. If all of them are to be on a linear scale, choose Linear for the y1 scale. Choose Log if they are all to be log. Choose Use Mixed Y Axes if both linear and log quantities are to be plotted on the y-axis.

X Quantity
One quantity can be chosen for plotting on the x-axis. All quantities available in all selected plots appear in this list. If one of the plots does not have data for the chosen quantity, nothing is drawn.

Y Quantities
Any number of quantities can be chosen for plotting on the y-axis. All quantities available in all selected plots appear in two lists. The Y1 Scale controls whether the Y Quantities 1 list is linear or log. The Y2 Scale similarly controls the Y Quantities 2 list. The Y Quantities 2 list is only available if Use Mixed Y Axes is selected.

A menu attached to each list (accessed by pointing to the list and clicking on the MENU mouse button) makes list control a little easier. There are options to move selections from one list to the other, and for rapidly selecting, deselecting and locating choices in the lists.

Group
When Cartesian data is plotted that contains different groups of data sets for the same y quantity, this item can be used to specify which quantity divides the y value into its distinct groups. For example, a structure may contain data to show several plots of drain current against drain voltage for different values of gate voltage. In this case, the x-axis would be set to “drain voltage”, the y-axis to “drain current” and the Group item to “gate voltage”. The plot would show one curve of Id vs. Vd for each value of Vg.

Polar Charts

When the graph type is Polar, four subpanes are shown. Each subpanel can be used to display quantities. In other words, up to four polar curves can be plotted.

Two quantities are used to specify each curve. By default, the quantities real and imaginary are used when the data is not converted. If the data is to be converted, the quantities R (radius) and A (angle) are used. The data should only be converted if it appears in (r, theta) form in the structure. When quantities are present that TonyPlot recognizes as being usually displayed on polar charts, TonyPlot tries to automatically select an “i” (or “A”) quantity whenever you choose an “r” (or “R”) quantity.

The real or radius quantity can be logged before plotting, and the angle quantity can be specified in terms of degrees or radians. Choose the setting which corresponds to the data in the structure.

There are some options to control the polar chart drawn. The chart can be drawn proportionally (e.g., concentric circles appear as circles, even if the plot window is not square) and radial labels can be shown in degrees (radians is the default). The radial lines can be drawn at various intervals. Choose the interval desired from the item marked Radials.
Smith Charts

When the graph type is Smith, four subpanels are shown. Each subpanel can be used to display quantities. In other words, up to four Smith curves can be plotted. This is basically the same as Polar charts described previously.

Two quantities are used to specify each curve. By default, the quantities real and imaginary are used when the data is not converted. If the data is to be converted, the quantities R and X are used. The data should only be converted if it appears in R, X form in the structure.

When quantities are present that TonyPlot recognizes displayed on smith charts, TonyPlot tries to select an “i” (or “X”) quantity whenever you choose an “r” (or “R”) quantity. There are some options to control the Smith chart drawn. The chart can be drawn proportionally (e.g., concentric circles appear as circles, even if the plot window is not square), and axis arms can be drawn in all four Smith quadrants (only the first quadrant is shown by default).

2.5.3 Cross Section Display

The Cross Section dialog box (Figure 2-70) shows the current display settings for the first selected XSection plot. See Cutline on page 55 for details on how to generate Xsection plots. When the settings on the display dialog box are applied, all selected XSection plots are affected. This permits much easier application of global changes to similar plots in the view. The Cross Section dialog box contains all the controls needed for complete control of XSection plots.

![Figure 2-70 Cross Section dialog box](image-url)
The following items can be specified:

- **Quantity**: This specifies quantities to be plotted. The available quantities are listed in the list that appears on the left hand side of the **Cross Section** dialog box window. Any number of quantities can be plotted. One of two functions can also be chosen. These functions are defined from the Functions dialog box. See Functions on page 23 for more information.

- **Options**: This allows you to add mesh, interfaces, and materials to the plot. These options are represented by the three icons in the top right of the dialog box. To add any of these features to the plot, select the corresponding icon. The icons underneath control the way lines are drawn on the graph.

The icons allows you to draw points or line or both segments.

- **Axis Scales**: Each quantity that you can plot on a **Cross Section** plot has a default flag, which TonyPlot uses to determine whether to use a Linear or Log y-axis. If you plot linear and log quantities simultaneously, two y-axes will be drawn. One to show all log quantities, and the other to show all linear.

- **Functions**: Click on this button to display the **Functions** dialog box. This dialog box can be used to define the functions that can be selected from the choice of **Quantities**. See Functions on page 23 for more information.

The type of y axis drawn depends on the quantities being plotted. If log scale quantities are drawn, such as **Net Doping**, then TonyPlot draws a true log scale axis. If linear quantities are drawn, such as **Potential**, a normal linear axis is drawn. If a mix of the types of quantities are drawn, TonyPlot draws both types of axis: the log axis that appears on the left side of the subwindow, and the linear axis that appears on the right. When reading values from the curve, be sure to use the correct scale.

For dopants, the log axis shows values below 1e12. You can change this value in the **Plot Options** panel of the **Preferences** dialog box (see Preferences on page 28).
2.5.4 RSM Display

The RSM Plot display dialog box allows you to control the display of the Response Surface Model (RSM) inputs and outputs. RSM plots can be drawn in one of three modes: **1D graphs**, **2D contours**, or **3D surfaces**.

![RSM dialog box](image)

To draw any RSM plot, TonyPlot “samples” the input(s) a number of times to calculate values for the output. The number of samples taken (which are always regularly spaced) is determined by the setting of the **Density** item. Higher densities generate more points, creating smoother curves or surfaces, but take longer to compute. Low density plots are quick to calculate and draw, but provide only “approximate” plots.

For total control of RSM plots and access to a selection of analysis tools, enable the VWF Production Mode. A description of these features can be found in the Chapter 5 Production Mode. Without **Production Mode**, the benefit of RSM plots is greatly reduced.
1D RSM Graphs
When you plot RSMs in the 1D mode, you can select any one input for the x-axis, and you can select any output(s) for the y-axis. All RSMs that contain both the input and output are plotted.

Show
There are a number of ways to display data on 1D RSM plots. These are selected from the row of icons near the top of the control panel.

- **Points/Lines**: draw points and line segments at or between sampled points, to draw the curve. SPC limits can be added to the plot, if this information is available for the outputs being plotted. activates the **Valid X Range** marker, showing the range of the input that is valid for the model used. The drawn range can be extended in certain cases to values outside the valid range. represents **Measured Points**, which are plotted if measured data was passed with the RSM. normalizes all outputs to a range between 0 and 1, for easier comparison of different models. activates a **Gunsight**, which can be used to track x- and y-coordinates along the curve.

- **X Quantity**: Any input parameter can be chosen for plotting on the x-axis. In addition, values of this input can plotted on a log scale.
- **Y Quantities(s)**: Any output parameters can be chosen for plotting on the Y axis. There are two lists: one for outputs to be plotted on a linear axis, and one for a log axis. Any combination of the two can be used.

2D RSM Contours
In the 2D mode, RSM plots show how outputs vary with respect to two independent input parameters. You can specify the way to draw contours the same way contours are drawn in regular 2D Mesh plots from Atlas or Athena.

X and Y Quantities
You must choose two inputs for contour plots: one for the x-axis and one for the y-axis. The inputs chosen must be different. Each of these can be plotted on a log scale if desired.

Z Quantity
The Z Quantity cannot be chosen (it is always the RSM output parameter that is plotted). But you can specify a linear or log scale for the Z axis.

Contour Type
Contours can be drawn as lines or filled areas, and filled areas can be outlined. There are a number of color sets that can be used to create the contours. All these options are controlled with the items in the lower left corner of the control panel.
**Mesh**

Next to the icons for controlling the contour types is an icon that draws the “sample mesh” on top of the contour plot. This mesh shows the points where outputs were calculated to generate the plot. A triangular mesh is created from these points to draw contours.

**Projection**

This is not used in the 2D mode. See 3D on page 100 for an explanation.

**Output Range**

The range over which contours drawn can be selected as one of two options. The first option is to use the highest and lowest output values over the sampled input range. This ensures all contour colors are drawn on the plot. The second option is to use to absolute range of the model output, which can be a greater range than that plotted.

**3D RSM Surfaces**

When you choose the 3D mode, TonyPlot draws an RSM as a three dimensional surface with contours draw according to surface “height”. Control over the display of these plots is the same as described above for 2D plots, except that projection may also be specified. **Projection** allows you to choose either parallel or perspective projections when the 3D surface is displayed.

---

**Note:** These 3D plots can be rotated and scaled (but not zoomed). See Section 2.3 Plot Control for details on 3D rotation and scaling.
2.5.5 Statistics Display

Whenever statistics plots are present, the Statistics Plot Display dialog box can be used to alter the way the data is displayed. These Statistics Plots are often generated from Production Mode tools (see Chapter 5 Production Mode).

Figure 2-72 Statistics Dialog

Statistics plots can be one of several distinct types. These are Histogram, Pie Chart, Scatter Plot, Box Plot, and Sunray Plot. The current type is shown at the top of the dialog box. To change the type, select it from the Type menu. For each type, a different set of control appears beneath, on the lower portion of the dialog box.
Histograms

X Axis
You can plot one or more quantities on a histogram plot. Choose the quantities desired from the scrolling list to the right.

Stack
When you plot more than one quantity, the stack item selects the method used for showing each one on the same axis. You can stack the bars for each quantity vertically on top of each other or horizontally next to each other.

Fit
This item allows you to plot a best-guess distribution curve over the data. TonyPlot uses the range, mean and standard deviation of the data to generate a distribution curve of the chosen type.

Show
The icons along the bottom control what items can be drawn on a histogram plot.

- **Lines** draws from one bar to the next.
- **Solid Bars** draws a standard bar chart. This is the default option.
- **Jitter Plot** shows the distribution of all the data points.
- **Cumulative Curve** shows the total number of data points over the X axis range.
- **SPC Limits** are drawn when RSM output quantities are plotted on the histogram. See Section 5.2.9 SPC Limits for information about SPC limits.

Pie Charts
Controlling of pie charts is simple. Just select the quantities to be displayed from the list, and a pie will be drawn for each of them. To remove a slice from each pie, enter the number of the slice into the text field labeled *Remove Slice*. A value of zero means “remove no slice”.

Scatter Plot
Scatter plots show distributions of data in an x-y graph. By selecting various parameters for the X and Y axes, you can see the correlation of parameters graphically.

X Axis
Choose one quantity to be plotted along the X axis.

Y Axis
Choose one or more quantities to be plotted along the Y axis.
Box Plot

Box plots are used to examine the overall structure of the data. Use the list to select the quantities to be plotted, and a box will be drawn for each one. You can display the boxes horizontally or vertically. When they are displayed horizontally, you can add a jitter plot. A jitter plot shows the distribution of all the data points for each box.

Sunray Plot

Sunray plots show data values distributed around a central point with the distance of each point from the center proportional to the data value. This yields a star or hedgehog-like plot (see Figure 2-73).

Select the quantities to be plotted from the scrolling list, and a sunray plot will be drawn for each one. The icons along the bottom control how to draw the sunray plots. These are circumference lines, radial lines, and an bounding circle whose radius is the maximum data value.

Figure 2-73  Sunray Plot
Chapter 3
Data Files
3.1 User Data Files

User data files are ASCII text files that can be loaded into TonyPlot and have a easy-to-read format. This means that data from external sources can easily be read into TonyPlot. Those who have their own sets of data already, maybe from other software packages or from experimental results, find this format useful, since it allows you to apply the features of TonyPlot to that data. You can also compare data files to other files types. This makes it simple to compare simulation results from Silvaco simulators with data obtained from experiments.

3.1.1 Loading User Data Files

TonyPlot automatically recognizes data files in this format. Therefore, it is unnecessary to use any special command line options to load them. They can also be loaded using the File Loader dialog box, just like regular Silvaco files.

3.1.2 Creating User Data Files

Data files can be created in any manner. From other programs, filters, or TonyPlot features, such as Export. If needed, you can also edit the files.

3.1.3 Data Format

Data files should be constructed in the following manner.

```
<title line>
<r> <c> <t>
<title 1>
<title 2>
...
<title t>
<x11> <x12>  ......  <x1c>
<x21> <x12>  ......  <x2c>
<x31> <x12>  ......  <x3c>
...... ...... ...
<xrl> <xrl>  ......  <xrc>
```

`title line` can be any sequence of ASCII characters. This is used as the main plot title, and must be present.

`r` is the number of rows in the file. This must be present, but can be given as zero, in which case TonyPlot works out how many rows there are.

`c` is the number of columns. This must be present, but can be given as zero, in which case TonyPlot works out how many columns there are.

`t` is the number of column titles. If not present, it defaults to zero (i.e., no titles).

`title X` is the title that is assigned to the data in column number X. These titles are optional, but if given, the number of titles must match the `t` parameter in the second line.

`xij` is a data value, in row i, column j.
Each column in the file represents data values for a certain quantity. If no titles are given, these quantities assume default names User data 01 for the first column, User data 02 for the second, and so on. The titles allow you to add more meaningful names.

### 3.1.4 Examples

The following are examples of some user data files and descriptions of each. These can be entered into a text file and tested with TonyPlot, if needed.

**Equation**

This simple example plots a section of a curve of the equation $y = \sin(x)$. This type of file is the simplest.

```plaintext
y = sin (x)
10 2
0.1 0.09983
0.2 0.19867
0.3 0.29552
0.4 0.38942
0.5 0.47943
0.6 0.56464
0.7 0.64422
0.8 0.71736
0.9 0.78333
1.0 0.84147
```

**Transistor**

This example contains information about an NMOS transistor. This example shows how columns are named.

```plaintext
1.0 um NMOS Id/Vg
10 2 2
gate bias (V)
drain current (A)
0.0 1.0E-14
0.1 1.0E-13
0.2 1.0E-12
0.3 1.0E-11
0.4 1.0E-10
0.5 1.0E-09
0.6 1.0E-08
0.7 1.0E-07
0.8 5.0E-07
```
Display

User data files are treated in the same way as normal XY Graph plots in TONYPLOT. This display dialog box for these plots is exactly the same as the Graph display dialog box. In fact, once loaded into TonyPlot, there is no difference between these two type of data at all.
3.2 Set Files

When a plot has been set up to display the desired set of information (e.g., using the display dialog boxes, labels, annotation), it is possible to save this information into a set file so that the display can be recreated automatically by TonyPlot. A set file contains instructions that tell TonyPlot the steps needed to recreate the same display that was visible at the time the set file was created.

Therefore, when you load the same data files into TonyPlot at a later date, or into a different TonyPlot, loading the set file avoids having to go through all the dialog boxes again.

By convention, set files usually have a suffix of .set which denotes them as set files. The Set File Loader uses a .set default filter.

3.2.1 Creating

To create a set file, choose File→Save Set Files. Move to the directory where the set file is to be created, and enter the name of the desired file into the field marked File name. If the file already exists, select it from the scrolling list (use the Filter to screen out undesired files from the list). When you click on the Save button, the set file will be created. Confirmation is required if the file is overwritten.

3.2.2 Loading

To load a previously created set file, locate the file by select the File→Open Set Files. Then, click on the Open button and the view will update. You can also load set files from the command line with the -set option. If an error occurs when loading the file, a warning notice appears.

When a set file is created while there are multiple plots in the view, it is important that the same plots are present when the set file is loaded, since a set file cannot store information about duplicated or deleted plots. For example, suppose TonyPlot is started with the name of one data file:

% tonyplot diode.str

When the plot appears, you can show contours in one window and the mesh in another. The plot is duplicated to allow this, and the appropriate display parameters is applied to each plot. A set file is then saved called (for example) setup.set. You then quit from TonyPlot.

At a later date, if the same view is to be created automatically, you must enter:

% tonyplot diode.str diode.str -set setup.set

because there were two plots of diode.str when the set file was created. If only one file name was given, the set file would not be loaded completely.

Similarly when plots are deleted, restart TonyPlot only with the names of files that were being plotted when the set file was created.

Set files cannot record any actions you performed to create overlay plots, although they can store setup information about the overlay itself. Therefore, you must recreate the overlay manually before loading the set file. For example, suppose you start TonyPlot with the following two data files:

% tonyplot drn.log src.log
and you then overlay these two files. Also, assume you delete the second plot. In other words, the plot of src.log, leaving a plot of drn.log, and a plot of both data sets overlaid. Then, save a set file called log.set. To recreate this view in another TonyPlot window, you must enter:

% tonyplot drn.log drn.log -overlay src.log -set log.set

This also illustrates the point about not including filenames from deleted plots when restarting.

**Note:** The deleted src.log plot was not included in the command to restart TonyPlot.

Cross section plots that are generated using the **Cutline** tool can be created from the original 2D Mesh plot using set files. Therefore, you can save a view with a mesh and a cross section and recreate it from the mesh alone. For example, suppose you load a mesh file called pmos.str, creates a cutline cross section, and then saves a set file called cut.set. You can then recreate the view with:

% tonyplot pmos.str -set cut.set

The set file automatically takes a cutline from the PMOS mesh and display the cross section plot as it appeared when the set file was created.

### 3.2.3 Setfile Syntax

Set files use TPCS statements to store setup information. Also included in a set file is the version of TPCS used to create the file. Those familiar with TPCS commands will be able to create set files or modify existing set files manually. Set files can also be used as examples of various TPCS syntax rules. See **Section 2.3.3 TonyPlot Command Stream** for more information.
4.1 Overviews

One of TonyPlot’s most useful features is the ability to directly compare different sets of structure data. This not only means loading several output files at once and looking at each one in the same view, but also overlaying the data sets in the same plot subwindow.

When different files are overlaid, the plot is called an overlay plot, and has some characteristics not shown by normal plots. Each structure is drawn on a separate level in an overlay plot, and the levels are transparently stacked upon one another. Each level uses the same axes and display settings, so that the data can be readily compared. Obviously, each level must be of the same plot type (2D Mesh, Cross Section or XY Graph).

4.1.1 Making An Overlay

There are two ways to create overlay plots. One way is if the files to be overlaid are already loaded into TONYPLOT (each in its own plot subwindow), select the plots to be overlaid (at least two must be selected) and select Edit→Make Overlay. A new plot is created containing one level for each plot selected. Another way is if data that is to be overlaid is not loaded, the new files can be overlaid onto an existing plot as they are loaded. To do this, use the Overlay dialog box or the -overlay option if loading from the command line.

4.1.2 Splitting An Overlay

An overlay plot can be broken down into separate single-level plots by choosing the Edit→Split overlay. The overlay plot to be split must be selected when this option is chosen. One new plot will be created for each level in the overlay.

4.1.3 Overlay Control

Overlay plots are controlled just like any other plot. It is still a single plot even though several structures are displayed within it. Controls such as zooming, key commands, or labeling are still possible as though only one structure were present.

4.1.4 Overlay Display

Plot display for an overlay plot is exactly the same as for a normal plot, except that multiple data sets are affected. All the data sets (i.e., every level) is displayed according to one common display setting. It is impossible, for example, to show contours in one level and vectors in another. Since each level must be of the same plot type, the dialog box used to change the display settings are the same as described for normal plots.

Some levels may not be plotted if the display settings includes quantities or options that are not present in the data for that level. The display dialog boxes, however, shows all quantities from all levels. For example, one level may contain boron and another level just arsenic. The display dialog box shows both boron and arsenic. If you only choose boron, only the first level will be drawn.
4.1.5 Identifying Data

Data from separate levels can be identified by the overlay key. This key indicates which profile or graph line corresponds to a certain data file. The quantities plotted are identified with the same key used in single-level plots. Each level is shown in a different color, (line type for monochrome screens) and each quantity with a different mark type. The colors used are determined by the current set of **Sequence colors**. See **Preferences on page 28** to determine how to set these colors.

Mesh plots, when overlaid, use the same color for each level. Because of the large amounts of information that can be portrayed in a 2D Mesh plot, the number of levels is limited to three. For **XYGraph** and **XSection** plots, there is no practical limit.

4.1.6 Level Names

Each level in an overlay is named from the file from which its data was taken. If needed, these names can be changed with the **Level names** dialog box. Choose **Plot → Level names...** to display this dialog box.

To change the name of a level, first select the old name from the scrolling list. Then, enter a new name into the text field labeled **Name** and click on the **Apply** button. The plot updates to show the new names.

4.1.7 Cutlines

When the **Cutline** tool is used on an overlay 2D Mesh plot, a section is taken from each level. **TONYPLOT** automatically overlays each of these when it creates the new cross section plot.

4.1.8 Preferences

There are some **TONYPLOT** preferences that apply to overlays. These are accessed by choosing **Overlay Options** from the Preferences dialog box. Although explained in the **Preferences on page 28**, they are briefly described here.

- **Creating**: When creating overlays from existing plots, **TONYPLOT** just creates a new plot. The old plots still remain in the view. If you choose the **Deletes originals**, however, the plots that made up the overlay will be deleted when you create the overlay.
- **Level colors**: As explained above, each level is identified with its own color. If the same color is to be used for all levels, choose **Single** for this property.
- **No. of levels**: As explained previously, the number of levels in a plot is limited. You can override, however, this limit and have as many levels as required in an overlay. Use this switch to toggle this limit.
- **Display option**: Although the default setup is to use different colors for different levels and different mark symbols for different quantities, this can be reversed by using the **Display** option property. Select **color/mark** or **mark/color** as desired.
Chapter 5
Production Mode
5.1 Overview

TonyPlot provides the graphics to examine and interact with response surface models (RSMs) in one, two or three dimensions. These RSMs can be examined with a selection of Production Mode features, such as Failure Analysis, Disposition, and Synthesis. This section discusses the advanced Production Mode features available.

An RSM consists of a “response parameter”, sometimes called an “output” or simply “model”, and a number of “input parameters”. The output is calculated from the inputs according to the RSM definition, which is passed from VWF to TonyPlot.

RSM plots are displayed as either simple XY graphs, where the model is plotted against the variation of one input, or as 2D or 3D contour plots, where the model is plotted against two inputs. In all cases, inputs not plotted are held at fixed values, although you can set these fixed values.

Controlling RSM plots are described Section 2.5.4 RSM Display. See those pages for an explanation of how to draw RSM graphs, contours and surface plots.

5.1.1 Enabling Production Mode

There are three ways to enable the RSM graphics in TonyPlot. The simplest way is to let TonyPlot do it automatically: whenever an RSM plot is loaded, the Production Mode is started. The second way is to choose File→Production Mode. The third way is to do it via Spayn/VWF. In VWF, select Tools→Spayn to load a worksheet into Spayn. From Spayn, use Tools→Regression to create the RSM and then start TonyPlot (please see the VWF and Spayn User Manuals for further details).

When Production Mode is enabled, the Production menu (between the Tools and Help menus) becomes active.

This menu allows access to each of these Production Mode features (Interactive control, Failure Analysis, Calibration, Synthesis and Yield Analysis) as well as some parameter editing dialog boxes (e.g., Input range, SPC limits). Choosing any of the main features displays the Production dialog box in the appropriate mode. Selecting one of the editing dialog boxes displays that dialog box.
5.2 The Production Mode Dialog Box

By selecting an option from the main Production menu, the Production Mode dialog box appears. This dialog box shows all the RSM input and output parameters currently in use, and allows the selection of some advanced features. The dialog box can be set to one of five “modes” (Interactive control, Failure Analysis, Calibration, Synthesis and Yield Analysis) by either choosing the mode from the Production menu, or from the choice item at the top of the dialog box.

Below the mode selector is a panel whose contents depend on the mode currently selected. In the Interactive mode, for example, it shows the current Process Name (if any) and a row of four buttons for control of the input sliders.

The input sliders appear on the next panel down. Each input parameter in use is represented as a slider/toggle combination. Inputs can be “selected” by pressing the toggle — it is grayed out when not activated.

The dialog box can show up to twenty four inputs. You can expand or reduce size of the dialog box to show more or less sliders. The bottom of the dialog box has the usual Cancel and Ok buttons.

5.2.1 Interactive RSM Control

The Interactive mode is the basic use for the Production dialog box. When set to this mode, the mode control panel shows the current Process Name. This name can be changed if needed. Under the process name are three buttons that control the input parameter sliders:

- **Reset to nominal**: Clicking on this button sets all slider positions to the nominal value for each input. The nominal value is defined by the RSMs, but can be changed to any other value with the Input Parameter Ranges dialog box (see Section 5.2.7 Input Parameter Ranges) or with the next button.

- **Store as nominals**: Clicking on this button uses the current position of all selected input sliders as a new nominal value for those inputs. You can also set nominal values from the Input Parameter Ranges dialog box.

- **Fix Y Axis**: When you toggle this option, the y-axis ranges of the selected RSM plots remain when you move the input sliders.
5.2.2 The Input Sliders

Any input slider that is selected (i.e., the toggle is green) can be dragged left and right to interactively change the current value of that input. As the value changes, any selected RSM plots in the current view updates to reflect these new values. Any selected RSM plot is updated as follows:

- Any 1D RSM plot that has the input plotted on the X-axis moves the gunsight along the curve to match the changing X-axis value. If the input is not the X (or Y) quantity, the whole curve will be recomputed for the new value.
- Any 2D plot that doesn’t have the input as either the X- or Y-axis quantity is redrawn with the contours recalculated for the new input value.
- Any 3D plot that doesn’t have the input as either the X- or Y-axis quantity is redrawn with the contours and surface recalculated for the new input value.

Note: Since plots are updated interactively, it is usually preferable to set the RSM plot density to “low”. This speeds up the calculations and greatly improves the response time.

This interactive control is available regardless of the current dialog box mode. That is, sliders can be dragged in any of the production modes, and plots are still updated interactively as described in Section 5.2.1 Interactive RSM Control.

5.2.3 Failure Analysis

The Failure Analysis feature can be used to predict which input parameter is the most likely cause of an error in production. In other words, an output parameter or measurement that exceeds the specification or design limits.

Set up

When the Production dialog box is set to Failure Analysis, there is a list of all output parameters, a text field for entry of “failed values” and START and STOP buttons. There is also a Method item.

- Failed Values: For each output parameter, enter the failed value that was measured at the production site. Press the Return key to submit this value to the list.
- Method: This controls the error tolerance method used in the failure analysis. Higher orders are less error tolerant, lower orders are more tolerant.
- Select Inputs: From the set of input sliders, choose the ones to be used in the analysis. TonyPlot tries to find which of these inputs is the most likely cause of failure in all outputs. You must at least select two inputs because the algorithm compares relative probabilities of failure cause.
- START: Click on this button to start the failure analysis. As each of the selected input parameters are tested, its slider moves from the minimum to the maximum value. Once all inputs have been tested, a plot of the results appears.
- STOP: Click on this button to stop the analysis at any time. All calculations are aborted and no result plot appears.
Result Plot

When you run the failure analysis, a barchart appears (which is a form of the general TonyPlot Stat plot). The barchart shows the relative probabilities of each input being the cause of the failed values.

**Note:** Each input is tested individually. The analysis tries to find the one single input that could cause the specified failure in all outputs. The highest bars show inputs that are most likely to have caused the failure(s).

TonyPlot also adds a set of labels to the plot. These labels indicate the values of each input which would have generated the failed value, if that input had been the cause of the failure.

5.2.4 Calibration

The initial condition of the calibration function requires an overlayed display of the measured and RSM data to be made. At this time, choose which parameters are to be varied to do the calibration. Your choice is to set the process parameters to be fixed while the model parameters are allowed to vary.

Setup

To use the calibration tool for VWF, do the following:

1. Generate a Design of Experiments (DOE) employing the “Most Practical and the Most Important” Process Parameters and the “Most Important” Calibration Parameters. Split lots can be Orthogonal DOEs or Random DOEs.
2. Run the Simulation Split Lot in Parallel on MP machine.
3. Generate RSM for each Process Parameter.
4. Load the (Calibration Parameters and Processing Parameters) RSMs into TonyPlot.
5. Load in the measured data into the Production Tools. Production Tools will find values of Calibration Parameters that will best fit the measured data.
6. Save these RSMs for later use with Production Tools Yield Improvement Failure analysis.
7. Update the Calibration Coefficients for future use in future baseline input decks.
5.2.5 Synthesis

In Synthesis mode, TonyPlot tries to find a value for each selected input that produces a desired set of outputs. Two algorithms are provided to perform this reverse calculation — a “Levenberg-Marquardt” optimizer and a method known as Adaptive Simulated Annealing.

Setup

Before starting the synthesis calculations, you must set the desired output values. Use the text field labeled Target Value to enter a desired value for the output currently selected in the list on the left. Press the Return key to submit this value.

When all target values are entered correctly, select the desired method. There is a choice between the Levenberg-Marquardt optimizer and Adaptive Simulated Annealing. Select the method desired.

Select the input sliders that are to be used in the synthesis: not all of them need to be used. Unselected inputs will be fixed at their current values when the RSM computations use them. Certain operational parameters specific to each synthesis method can be customized to help obtain the required results. See Sections 5.2.11 Optimizer Setup or 5.2.12 ASA Setup for further details.

Click on the START button to start the synthesis procedure. As the calculations progress, the latest results achieved will be displayed in the Current value text field. A status message describes the current state.

To abort the synthesis at any point, click on the STOP button. The procedure is cancelled and reset.

Results

The inputs sliders changes as the synthesis calculations progress. When the procedure is successful and complete, the input slider positions shows the values of the inputs needed to produce the output value(s) that were specified in the list of targets.

5.2.6 Yield Analysis

Yield Analysis is a prediction tool used to simulate yield in a real-life fab. TONYPLOT generates large numbers of output measurements from a statistical sample of many inputs. By specifying the probability distributions of each input parameter, a total distribution of all outputs can be obtained.

The statistical distributions of input parameters are obtained in several ways. First, they can be passed to TonyPlot along with the actual RSM data that uses the inputs. If none pass, TonyPlot generates a default distribution. Finally, all input distributions can be specified using the Input Distributions dialog box (see Section 5.2.8 Input Distributions).

Setup

The first thing to set up before running a Yield Analysis is the input distributions. The scrolling list on the Production dialog box shows the distribution types for each input.

To examine the distributions in detail, and possibly alter them, use the Input Distributions dialog box.

The number of samples taken by TonyPlot of each input parameter can be set to any value. The default is 5000 samples. The more samples that are taken, the more accurate the results, but it takes longer to perform the analysis.
Click on the green **START** button to start the analysis. The number of samples taken is continuously displayed next to the start and stop buttons. To abort the analysis at any time, click on the **STOP** button.

When all samples have been taken, TonyPlot takes a few moments to collate the data it has obtained, and then a barchart is plotted.

**Results**

The default result plot that Yield Analysis creates is a barchart showing the distribution of the output parameter(s). This plot is an instance of a standard **Statistics** plot, and can be manipulated further with the normal dialog boxes for **Statistics** plots.

The plot also contains data for all the input values that were used: these can also be plotted. Use the Stat plot **Display** dialog box to select sets of data to be plotted, and the type of plot. It is possible to draw pie charts, scattergrams, box plots, and other figures, to examine the data. See Section 2.5.5 **Statistics Display** for more information.

**5.2.7 Input Parameter Ranges**

As RSM data is loaded into TonyPlot, a record is kept of the greatest range of each input parameter. Along with these minimum and maximum values, a “nominal” value is stored, which represents the normal, or default, value of that input. You can change the range or nominal value or both of any input by using the **Input Parameter Ranges** dialog box.

**Control Items**

The dialog box shows a list of all inputs from all loaded RSMs, and shows the minimum, maximum, and nominal values for each one. Underneath the list, the name and values for the input currently selected are displayed: the values can be changed but the name cannot. Press the **Update** button on each text field to submit new values to the list. **TONYPLOT** makes sure that the values are logical. In other words, the minimum is less than the maximum and the nominal lies between them.

Once you made all the desired changes to the list, click on the **Apply** button. This will submit these new values to TonyPlot. Any RSM plots are updated to use these new ranges and nominal values.

**Uses**

The **Input Parameter Ranges** dialog box affects the range over which values are taken for each input when RSM outputs are computed. The sliders on the **Production** dialog box reflect the current range for each input.

Some models may only be valid for specific ranges of their inputs. Since it is possible to exceed these ranges, there is a feature that allows the valid range to be identified on a 1D plot (see Section 2.5.4 **RSM Display** for more information).
5.2.8 **Input Distributions**

As RSMs are loaded into TonyPlot, a default distribution is assigned to each one. This distribution represents the statistical “spread” of values that would be obtained for this input parameter in an experimental situation. Using this data, TonyPlot can simulate real-life input values by sampling data with the given distribution parameters.

The default distribution given to each input is Gaussian with a mean value halfway between the minimum and maximum value of that input. The standard deviation will be 10% of the mean.

To alter the distributions for any input, use the **Input Distribution** dialog box.

**Control Items**

The **Input Distribution** dialog box shows a list of all inputs currently loaded and the type of distribution for each one, along with its mean and standard deviation.

Underneath the list, the values for the currently selected input are shown. The name of the input is fixed and cannot be changed but the other items can. Press the **Update** button on the **Mean** and **Std.Dev** text fields to submit changes to the list. If you select a new distribution type, the list will update automatically.

When you made all the desired changes, click on **Apply** to commit the new values. If the **Production** dialog box is set to **Yield Analysis** mode, the new distribution types are shown in the scrolling list.

To examine and alter the distributions graphically, press the **View...** button. This summons a small window showing a histogram distribution of the selected parameter. Select other parameters to view their distributions also. The sliders under the histogram can be used to modify the mean and standard deviation of the parameter. Click on **Apply** to save the values back to the original scrolling list.

**Uses**

Input distributions are used in **Yield Analysis**. When TonyPlot takes input samples, it uses these distribution parameters to generate realistic values that may be found in a real-life scenario. For accurate **Yield Analysis** results, each input distribution should be set up so that it matches as closely as possible that found by experimentation.

5.2.9 **SPC Limits**

Each output parameter used in **Production** mode has a set of Statistical Process Control (SPC) parameters, which can be used to monitor the value of some measured value. There are five SPC limits:

- upper spec limits (maximum values permitted)
- lower spec limits (minimum values permitted)
- upper and lower control limits (ideal maximum),
- lower control limits (ideal minimum)
- center limit (ideal value),

These limits are abbreviated to USL, LSL, UCL, LCL, and CL respectively. Values for each of these are sometimes passed to TonyPlot through the RSM data. If not, or if they need to be modified, the **SPC Limits** dialog box can be used to add or modify **SPC Limit** values for any output.
Control Items

The scrolling list on the SPC Limits dialog box shows all output parameters and the USL, UCL, CL, LCL, and LSL values for each one. Underneath the list are five text fields where these values can be changed. Use the scrolling list to select the output that is to be modified, and enter new SPC values into text fields provided. Press the Update button in each text field to submit changes to the list.

If an output parameter has no defined SPC limits, use the word None to indicate missing values. To remove defined values, enter the word None into the text field and click on the Return key. When you made all desired changes, click on the Apply button to store the new values. Values in the list are not stored until the Apply button is clicked.

Uses

SPC Limits are used to monitor measured output values to ensure that these values stay within predefined boundaries and generate some warning when the boundaries are crossed.

Outputs generated by RSMs in TonyPlot can be compared to SPC Limits in a similar way. As long as these values are defined, the control lines can be added to any 1D RSM plot. See Section 2.5.4 RSM Display for details on how to add these SPC limits to a plot.

5.2.10 Experimental Results

Each output parameter modeled by an RSM, has an associated experimental value, that was measured when the process input parameters used in the model were set to their nominal values. If no experimental value is given for an output, or one needs to be changed, choose Experimental Results from the Production menu to display this dialog box.

Control Items

The dialog box shows a scrolling list with a line for each output. Next to the name of each output are four values: Experimental Result, Modeled Result, Error Delta, and Predicted Value.

- **Experimental Result**: This is the measured value, which can be set from information provided by the RSM as it is passed from the VWF, or which can modified or added later using the text field underneath the scrolling list.
- **Modeled Result**: As previously mentioned, the experimental result is measured when all inputs are set to their nominal values. The modeled result shows the value that is calculated by the RSM and is a measure of the accuracy of the model. It also used to make a first-order error correction of the model.
- **Error Delta**: The error delta is the difference between the experimental measured value and the modeled value when all inputs are nominal. The smaller this error, the more accurate the model. This delta is used to error-correct the model.
- **Predicted Value**: This shows the modeled result after error-correction has been applied. It is the same as the experimental results, to show that after error-correction, the model is more accurate (when the inputs are nominal).

To change the experimental result for any output, select the appropriate row from the list, enter the new value in to the text field provided, and press the Update button. Once all new values have been made, click on the Apply button to commit the changes.
Uses

A measured result for an output parameter allows TonyPlot to make a simple error correction to a model of that parameter. The value shown as the “error delta” is added to values obtained from a model to “shift” the response curve to a more accurate position. The nominal case is used for this calibration (i.e., when all inputs are at their nominal values), and the result applied for all modeled values.

5.2.11 Optimizer Setup

The Synthesis mode of the Production dialog box provides two synthesis methods. One method is the Levenberg-Marquardt optimizer. The other method some parameters specific to this method can be customized as required.

To access the parameters, choose Optimizer Setup found on the Production dialog box. A dialog box appears, allowing customization of these parameters (default values shown in parentheses).

- Max. no of iterations (100)
- Norm of gradient bound (1e-6)
- Sum of squares difference (1e-11)
- Marquardt initial value (0.1)
- Marquardt scale factor (2)
- Marquardt upper bound (1000)
- Switch (0.1)
- Maximum Jacobian (100)
- Maximum RMS error (1)
- Maximum average error (1)
- Maximum maximum error (1)
- Maximum iterations (4)
- Noise level (1e-18)
- Error ceiling (100)

When you make all changes, click on the OK button to store them.
5.2.12 ASA Setup

The Synthesis mode of the Production dialog box provides two synthesis methods. One method is Adaptive Simulated Annealing (ASA). The other method some parameters specific to this method can be customized as required.

To access the parameters, choose ASA Setup on the Production dialog box. A dialog box appears, allowing customization of these parameters (default values shown in parentheses):

- Limit acceptances (10000)
- Limit generated (99999)
- Cost precision (5%)
- Maximum cost repeat (1)
- Number cost samples (5)
- Cost parameter scale (1)
- Temperature anneal scale (100)
- Testing frequency modulus (5)

When you make all changes, click on the OK button to store them.

ASA code is made available under terms of the GNU general public license for libraries. See the file $SILVACO/etc/GNU for details about this license.
Appendix A
TPCS Commands
A.1 TPCS Language

The following shows the syntax and the list of TonyPlot Command Stream (TPCS) commands. For more information about TPCS, see Section 2.3.3 TonyPlot Command Stream.

A.1.1 Syntax

<string>: This refers to an alphanumeric string. <string> must be enclosed in quotes. For example

"/home/john/work"

<expr>: A precision floating number for an mathematical expression. For example, 8.9426436430.

<integer>: A negative or positive whole number, or zero. For example, 8.

Commands that have an on|off option can be either one or the other. For example

show junctions on|show junctions off

A.1.2 Commands

print <string>: Prints the current plots to a postscript file specified by <string>.

Note: This is only available on the Linux platform.

save <integer1> <string> <integer2>: Saves the plot with index of <integer1> to the file name specified in <string>. <integer2> specifies the file format to use the following:

• 0 = BMP
• 1 = JPEG
• 2 = PBM
• 3 = PGM
• 4 = PNG
• 5 = PPM
• 6 = XBM
• 7 = XPM

draw <integer>: Draws the plot with the index of <integer>.

draw all: Draws all plots.

draw auto: Switches auto-redraw on or off.

load <string>: Loads the file specified by <string>.

load <string> replace: Loads a file specified by <string>, replacing the currently selected plot.

load <string> overlay: Overlays the file specified by <string> onto the first selected plot.

select <integer>: Selects the plot with the index of <integer>.

select all: Selects all plots.

select none: De-selects all plots.
delete: Deletes all selected plots.
duplicate: Duplicates all selected plots.
show mesh on|off: Switches mesh on or off.
show edges on|off: Switches edges on or off.
show materials on|off: Switches materials on or off.
show contours on|off: Switches contours on or off.
show vectors on|off: Switches vectors on or off.
show light on|off: Switches light beams on or off.
show junctions on|off: Switches junctions on or off.
show electrodes on|off: Switches electrodes on or off.
show threed on|off: Switches 3D on or off.
show points on|off: Switches points markers on or off.
show lines on|off: Switches line segments on or off.
show xaxis on|off: Switches the X axis on or off.
show yaxis on|off: Switches the Y axis on or off.
show axes on|off: Switches the X and Y axes on or off.
show grid on|off: Switches the XY grid on or off.
show label xaxis on|off: Switches the X axis label on or off.
show label yaxis on|off: Switches the Y axis label on or off.
show spc on|off: Switches SPC limits on or off.
show range on|off: Switches range on or off.
show measured on|off: Switches measured points on or off.
show normal on|off: Switches normalization on or off.
show probe on|off: Switches the probe on or off.
region param <integer>: Determines how regions are colored. An <integer> of -101 = by material, -102 = by region, -103 = by user data, and -104 = by triangle.
contours <integer> impurity <string>: Sets the impurity in contour set <integer> (1, 2, or 3) to that specified by <string>.
contours <integer> impurity <string1> <string2>: Sets the impurity in contour set <integer> to that specified in <string1>. <string2> specifies the type, "log", or "linear".
contours <integer> type lines: Draws contours as lines in the specified contour set given by <integer>.
contours <integer> type fill: Draws contours as filled in the specified contour set given by <integer>.
contours <integer> outline on|off: Switches contour outlines on or off for the contours set given by <integer>. 
contours <integer1> color <integer2>: Sets the color set given by <integer2> for the contours set given by <integer1>. <integer2> can be the following:

- 0 = Rainbow 30
- 1 = Rainbow 10
- 2 = Temperature
- 3 = Reds
- 4 = Greens
- 5 = Blues
- 6 = Gray Scale
- 7 = Level Colors
- 8 = Level Fixed

contours <integer> max auto: Turns on the auto maximum for the contour set given by <integer>.

contours <integer> max <expr>: Changes the maximum for the contour set given by <integer> to that specified by <expr>.

contours <integer> min auto: Turns on the auto minimum for the contour set given by <integer>.

contours <integer> min <expr>: Changes the minimum for the contour set given by <integer> to that specified by <expr>.

contours <integer1> nsteps <integer2>: Changes the number of steps in the contour set given by <integer1> to that specified by <integer2>.

contours <integer> increment <expr>: Changes the step increment in the contour set given by <integer> to that specified by <expr>.

contours <integer> materials all: Initializes the materials in the contour set given by <integer>.

contours <integer1> materials <integer2>: Allocates space for <integer2> materials in the contour set given by <integer1>.

contours <integer1> materials <string> <integer2>: Changes the material given by index <integer2> to that given by <string> in the contour set given by <integer1>.

contours <integer> apply: Applies all settings to the contour set given by <integer>.

threed impurity <string>: Sets the impurity given by <string> to the 3D elevation.

threed show edges on|off: Switches edges on or off for the 3D elevation.

threed show xaxis grid on|off: Switches the X axis grid on or off for the 3D elevation.

threed show yaxis grid on|off: Switches the Y axis grid on or off for the 3D elevation.

threed show xscale on|off: Switches the X scale on or off for the 3D elevation.

threed show yscale on|off: Switches the Y scale on or off for the 3D elevation.

threed show zscale on|off: Switches the Z scale on or off for the 3D elevation.

threed show mesh on|off: Switches the surface mesh on or off for the 3D elevation.

threed show grid on|off: Switches the base grid on or off for the 3D elevation.

threed apply: Applies all settings to the 3D elevation.
cutline from $<$expr1$>$, $<$expr2$>$ to $<$expr3$>$, $<$expr4$>$: Generates a cutline from ($<$expr1$>$, $<$expr2$>$) to ($<$expr3$>$, $<$expr4$>$) for the selected mesh.

light beam none: Turns off light beams.

light beam $<$integer$>$ on/off: Switches on or off the light beam given by $<$integer$>$.

light materials all: Initializes the light set materials.

light materials $<$integer$>$: Allocates space for $<$integer$>$ materials in the light set.

light materials $<$string$>$ $<$integer$>$: Changes the light set material at index $<$integer$>$ to that given by $<$string$>$.

light style $<$integer$>$: Changes the light set style. 0 = Solid and 1 = Lines.

light function $<$integer$>$: Changes the light set function. 0 = Wavelength, 1 = Power, 2 = Beam, and 3 = Ref. Index.

light color $<$integer$>$: Changes the light set color set to $<$integer$>$. $<$integer$>$ can be
the following:

• 0 = Rainbow 30
• 1 = Rainbow 10
• 2 = Temperature
• 3 = Reds
• 4 = Greens
• 5 = Blues
• 6 = Gray Scale
• 7 = Level Colors
• 8 = Level Fixed

light maximum $<$integer$>$: Changes the maximum reflection to $<$integer$>$.

light apply: Applies the current settings to the light set.

junctions show none: Turns off junctions.

junctions show junctions: Turns on junctions.

junctions show depletion: Turns on depletion edges.

junctions contours $<$expr$>$: Sets depletion edge value to $<$expr$>$.

junctions apply: Applies current junction settings

vectors impurity $<$string$>$: Sets quantity for vector display to $<$string$>$.

vectors impurity xaxis $<$string1$>$ yaxis $<$string2$>$: Set the X and Y components for vector display to $<$string1$>$ and $<$string2$>$.

vectors materials all: Initializes the vector display.

vectors materials $<$integer$>$: Allocates space for $<$integer$>$ materials in the vector display.

vectors materials $<$string$>$ $<$integer$>$: Changes the material given by the $<$integer$>$ index to the value given by $<$string$>$.

vectors maximum $<$expr$>$: Changes the maximum limit of banding to $<$expr$>$ for the vector display.
vectors minimum <expr>: Changes the minimum limit of banding to <expr> for the vector display.

vectors maximum auto: Automatically set the maximum limit of banding for the vector display.

vectors minimum auto: Automatically set the minimum limit of banding for the vector display.

vectors scale <expr1>, <expr2>: Sets the manual range clip from a minimum of <expr1> to a maximum of <expr2> for the vector display.

vectors color <integer>: Changes the vector display color set to <integer>. <integer> can be the following:

- 0 = Rainbow 30
- 1 = Rainbow 10
- 2 = Temperature
- 3 = Reds
- 4 = Greens
- 5 = Blues
- 6 = Gray Scale
- 7 = Level Colors
- 8 = Level Fixed

vectors apply: Applies current vector settings.

xsection impurity none: Turns on the xsection impurities off.

xsection impurity <string>: Adds the impurity given by <string> to all selected xsection plots.

xygraph yaxis none: Removes all data from the Y axis.

xygraph yaxis <string> log: Shows the parameter given by <string> on the Y axis in log format.

xygraph yaxis <string1> log <string2>: Shows the parameter given by <string1> on the Y axis in log format. <string2> specifies which side the parameter should use: "left" or "right".

xygraph yaxis <string> linear: Shows the parameter given by <string> on the Y axis in linear format.

xygraph xaxis <string> log: Shows the parameter given by <string> on the X axis in log format.

xygraph xaxis <string> linear: Shows the parameter given by <string> on the X axis in linear format.

xygraph type <integer1> convert <integer2>: Selects type of graph and conversion flag. The graph type is specified by <integer1> and can be 0 = Cartesian, 1 = Polar, and 2 = Smith. The conversion flag is given by <integer2> and can be either 0 = off or 1 = on. A value of 1 will tell TonyPlot to transform the coordinates before plotting them.
xygraph yaxis scale linear: Changes the Y axis scale to linear type.

xygraph yaxis scale log: Changes the Y axis scale to log type.

xygraph yaxis scale all: Changes the Y axis to use both sides.

xygraph polar <integer> <string1>, <string2>: Changes the real quantity to <string1> and the imaginary quantity to <string2> at the index of <integer>. If the conversion flag is set, <string1> is the radius quantity and <string2> is the angle quantity.

xygraph polar show <integer1> angle <integer2>: <integer1> specifies the following options selected:
- 0 = Not proportional and using radians for angle measurement.
- 1 = Uses proportional drawing for the plot.
- 2 = Uses degrees instead of radians.
- 3 = Uses proportional drawing and uses degrees instead of radians.

<integer2> specifies how often radial lines are drawn. The options are 15, 30, 45, and 90.

xygraph smith <integer> <string1>, <string2>: Changes the real quantity to <string1> and the imaginary quantity to <string2> at the index of <integer>. If the conversion flag is set, <string1> is the R quantity and <string2> is the X quantity.

xygraph smith show <integer> angle <expr1>, <expr2>: <integer> specifies the following options selected:
- 0 = Not proportional and axis arms in first quadrant only.
- 1 = Uses proportional drawing.
- 2 = Draws axis arms in all 4 quadrants.
- 3 = Uses proportional drawing and draw axis arms in all 4 quadrants.

<expr1> is the angle start of the innermost concentric ring. This defaults to 4.0.
<expr2> is the angle step between concentric rings. This defaults to 0.5.

xygraph group <string>: When Cartesian data is plotted that contains different groups of data sets for the same Y quantity, the quantity specified by <string> can be used to specify which quantity divides the Y value into its distinct groups.

rsm style <integer>: Sets the current RSM mode. 0 = 1D, 1 = 2D, and 2 = 3D.

rsm increment <integer>: Sets the RSM points density. 0 = low density, 1 = medium density, 2 = high density, and 3 = super density.

rsm xaxis linear <string>: Sets the X axis scale to linear mode and the quantity to <string>.

rsm xaxis log <string>: Sets the X axis scale to log mode and the quantity to <string>.

rsm yaxis none: Turns off all quantities for the Y axis.

rsm yaxis linear <string>: Adds the quantity given by <string> to the linear Y axis.

rsm yaxis log <string>: Adds the quantity given by <string> to the log Y axis.

rsm contours type lines: Changes the RSM contouring type to use line mode.

rsm contours type fill: Changes the RSM contouring type to use fill mode.

rsm contours outline on|off: Switches RSM outlining on or off.
rsm threed style <integer>: Changes the 3D projection mode to <integer>. 
<integer> can be 0 = Parallel or 1 = Perspective.

rsm range <integer>: Changes the range. <integer> can be either 0 = range or 1 = Z-Axis.

rsm range log: Changes the Z Scale to the log type.

rsm range linear: Changes the Z Scale to the linear type.

rsm color <integer>: Changes the RSM color set to <integer>. <integer> can be the following:
- 0 = Rainbow 30
- 1 = Rainbow 10
- 2 = Temperature
- 3 = Reds
- 4 = Greens
- 5 = Blues
- 6 = Gray Scale
- 7 = Level Colors
- 8 = Level Fixed

function <integer> <string1> <string2>: Defines function definitions. <integer> can be the following:
- 1 = Impurity function 1
- 2 = Impurity function 2
- 3 = Graph function 1
- 4 = Graph function 2
<string1> contains the function definition, and <string2> contains the units.

title main <string>: Sets the main title to <string>.

**title main auto**: Automatically sets the main title.

title sub <string>: Sets the sub title to <string>.

**title sub auto**: Automatically sets the sub title.

footer right none: Turns off the display of the right footer.

footer left none: Turns off the display of the left footer.

footer right <string>: Sets the right footer to <string>.

footer left <string>: Sets the left footer to <string>.

range xaxis <expr1>, <expr2> increment <expr3>, <expr4>: Sets the range for the X axis. 
<expr1> contains the minimum, <expr2> contains the maximum, <expr3> contains the division, and <expr4> contains the number of checks.

range xaxis auto: Automatically sets the minimum, maximum, division, and check spacing for the X axis.
range yaxis <expr1>, <expr2> increment <expr3>, <expr4>: Sets the range for the Y axis. <expr1> contains the minimum, <expr2> contains the maximum, <expr3> contains the division, and <expr4> contains the number of checks.

range yaxis <expr1>, <expr2> increment <expr3>: Sets the range for the Y axis. <expr1> contains the minimum, <expr2> contains the maximum, and <expr3> contains the division.

range yaxis auto: Automatically sets the minimum, maximum, division, and check spacing for the Y axis.

label xaxis <string>: Sets the X axis label to <string>.

label yaxis <string>: Sets the Y axis label to <string>.

zoom from <expr1>, <expr2> scale <expr3>, <expr4>: Sets the zoom of the currently selected plot. <expr1> and <expr2> contain the X and Y coordinates of the origin. <expr3> contains the scale in the X direction, and <expr4> contains the scale in the Y direction.

zoom out: Zooms out the currently selected plots.

zoom previous: Sets the zoom to the previously selected amount.

label <string> from <expr1>, <expr2> color <integer1> scale <integer2>: Places a label with the text <string> on the first selected plot, at the X coordinate of <expr1> and the Y coordinate of <expr2>. <integer1> specifies the color to use, and can be in the range of 0 to 89. <integer2> specifies the size of the label.

label <string> from <expr1>, <expr2> color <integer1> scale <integer2> to <expr3>, <expr4>: Places a label with the text <string> on the first selected plot, at the X coordinate of <expr1> and the Y coordinate of <expr2>. <integer1> specifies the color to use, and can be in the range of 0 to 89. <integer2> specifies the size of the label. Additionally, a line is drawn from the X/Y coordinates of <expr1>/<expr2> to <expr3>/<expr4>.

label <string> auto scale <integer>: Automatically places a label with text <string> on the first selected plot. <integer> contains the size of the label.

label <integer1> at <integer2> <integer3>: Changes the alignment of the label with an index of <integer1>. Two alignments are given, <integer2> and <integer3>, but only one is actually used. <integer2> can have the following values:

• 0 = Left Base
• 1 = Left Half
• 2 = Left Top
• 3 = Right Base
• 4 = Right Half
• 5 = Right Top
• 6 = Center Base
• 7 = Center Half
• 8 = Center Top

label <integer1> angle <integer2>: Changes the text direction of the label with an index of <integer1>. The possible values are 0 = Right, 1 = Up, and 2 = Down.
label overlay <integer> <string>: Sets the level name of an overlay. <integer> specifies the level number, and <string> specifies the text of the label.

key electrical at <integer>: Sets the position of the electrical key. The possible values for <integer> are:
- 0 = No corner
- 1 = Top Left
- 2 = Middle Left
- 3 = Bottom Left
- 4 = Bottom Right
- 5 = Middle Right
- 6 = Top Right
- 7 = Any Corner

key electrical at user <expr1>, <expr2>: Places an electrical key at the user defined X/Y position of <expr1>/<expr2>.

key contours <integer1> at <integer2>: Places a contours key using the contour set defined by <integer1> (1, 2 or 3) at the position defined by <integer2>. The possible values for <integer2> are:
- 0 = No corner
- 1 = Top Left
- 2 = Middle Left
- 3 = Bottom Left
- 4 = Bottom Right
- 5 = Middle Right
- 6 = Top Right
- 7 = Any Corner

key contours <integer> at user <expr1>, <expr2>: Places a contours key using the contour set defined by <integer> (1, 2 or 3) at the user defined X/Y position of <expr1>/<expr2>.

key regions at <integer>: Sets the position of the regions key. The possible values for <integer> are:
- 0 = No corner
- 1 = Top Left
- 2 = Middle Left
- 3 = Bottom Left
- 4 = Bottom Right
- 5 = Middle Right
- 6 = Top Right
- 7 = Any Corner

key regions at user <expr1>, <expr2>: Places a regions key at the user defined X/Y position of <expr1>/<expr2>.

key vectors at <integer>: Sets the position of the vectors key. The possible values for <integer> are...
• 0 = No corner
• 1 = Top Left
• 2 = Middle Left
• 3 = Bottom Left
• 4 = Bottom Right
• 5 = Middle Right
• 6 = Top Right
• 7 = Any Corner

key vectors at user <expr1>, <expr2>: Places a vectors key at the user defined X/Y position of <expr1>/<expr2>.

key overlay at <integer>: Sets the position of the overlay key. The possible values for <integer> are
• 0 = No corner
• 1 = Top Left
• 2 = Middle Left
• 3 = Bottom Left
• 4 = Bottom Right
• 5 = Middle Right
• 6 = Top Right
• 7 = Any Corner

key overlay at user <expr1>, <expr2>: Places an overlay key at the user defined X/Y position of <expr1>/<expr2>.

key opaque <integer>: Sets whether the key is opaque or not. A value of 1 means opaque, and a value of 0 means not opaque.

key apply: Applies all current key settings.

color window <integer>: Sets the Window color to <integer>. <integer> can be in the range of 0 to 89.

color background <integer>: Sets the Background color to <integer>. <integer> can be in the range of 0 to 89.

color foreground <integer>: Sets the Foreground color to <integer>. <integer> can be in the range of 0 to 89.

color dark border <integer>: Sets the Dark Border color to <integer>. <integer> can be in the range of 0 to 89.

color light border <integer>: Sets the Light Border color to <integer>. <integer> can be in the range of 0 to 89.

color zoom <integer>: Sets the Zoom color to <integer>. <integer> can be in the range of 0 to 89.

color grid <integer>: Sets the Grid color to <integer>. <integer> can be in the range of 0 to 89.

color mesh <integer>: Sets the Mesh color to <integer>. <integer> can be in the range of 0 to 89.
color edges <integer>: Sets the Edges color to <integer>. <integer> can be in the range of 0 to 89.

color cutline <integer>: Sets the Cutline color to <integer>. <integer> can be in the range of 0 to 89.

color junctions <integer>: Sets the Junctions color to <integer>. <integer> can be in the range of 0 to 89.

color electrodes <integer>: Sets the Electrodes color to <integer>. <integer> can be in the range of 0 to 89.

color outline <integer>: Sets the Outline color to <integer>. <integer> can be in the range of 0 to 89.

log label <integer>: Changes how log numbers are displayed. The possible values for <integer> are
• 0 = Do nothing
• 1 = Use 10^ notation
• 2 = Use 1e notation

mark frequency <integer>: Changes the frequency of the marks drawn on a curve. <integer> contains the frequency value.

mark overlay <integer>: Changes the overlay display options. <integer> can be 0 = Mark/Color and 1 = Color/Mark.

graph width <integer1> <integer2>: Sets the line width for the specified object. <integer1> contains the object type, and can be 0 = Edges, 1 = Arrows, 2 = Junctions, 3 = Cutlines, 4 = Graphs, 5 = Masklines, 6 = Victory Process Boxes, 7 = Victory Process Resolution Boxes. <integer2> contains the desired width for the line.

sequence size <integer>: Sets the size of sequence marks. <integer> contains the size.

sequence width <integer>: Sets the width of sequence marks. <integer> contains the width.

log zero <expr>: Sets the desired value for the log of zero. <expr> contains the value.

sequence mark <integer1> <integer2>: Sets the value of a specific sequence mark. <integer1> specifies which sequence mark to change, and can be a value of 0 to 5. <integer2> specifies the value and can be the following:
• 0 = Cross
• 1 = Circle
• 2 = Plus
• 3 = Triangle
• 4 = Square
• 5 = Star

help <string>: Returns help on the subject given by <string>.

quit: Exits from the Tonyplot Command Stream.
Appendix B
Models and Algorithms
B.1 Introduction

Models and Algorithms used by one dimensional (1D) electrical solvers in DeckBuild and TonyPlot.

Note: This appendix is intended to serve as a quick reference only. A detailed description of the semiconductor device physical models is provided in the Atlas User’s Manual.

1D electrical solvers, available by using the extract command in DeckBuild or in TonyPlot, are based on the iterative solution of the Poisson equation:

\[ \text{div}(\varepsilon \nabla \psi) = q\left(p - n + N_D^+ - N_A^-\right) - \rho_F \]  

where \( \psi \) is the potential, \( \varepsilon \) is the dielectrical permittivity, \( n \) and \( p \) are the electron and hole concentrations, and \( \rho_F \) is the fixed charge.

QUICKBIP uses the continuity equations to calculate \( n \) and \( p \):

\[ \frac{1}{q} \text{div} J_n - U_n = 0 \]  

\[ \frac{1}{q} \text{div} J_p - U_p = 0 \]

where:

\[ J_n = q \mu_n E_n \cdot n + q D_n \nabla n \]  

\[ J_p = q \mu_p E_p \cdot p + q D_p \nabla p \]  

\[ D_n = \frac{kT}{q} \mu_n' \]  

\[ D_p = \frac{kT}{q} \mu_p' \]

B.1.1 Physical Models

All electrical solvers take into account the following models and effects:

- Temperature dependence, such as \( kT/q \) or \( E_g \)
- Concentration-dependent mobility (with built-in temperature dependence)
- Field-dependent mobility (perpendicular field with built-in temperature dependence)
- Material work function (for MOS structures)
- Fixed interface charge
B.2 Concentration Dependent Mobility

The concentration dependent mobilities for \( n \) and \( p \) respectively are:

\[
\mu_n = \mu_{nmin} + \frac{\Delta \mu_n}{1 + \frac{N_{total}}{N_{nref}}} \quad \text{B-7}
\]

\[
\mu_p = \mu_{pmin} + \frac{\Delta \mu_p}{1 + \frac{N_{total}}{N_{pref}}} \quad \text{B-8}
\]

where:

\[
\mu_{nmin} = 88 \left( \frac{Y}{300} \right)^{-0.57} \quad \text{B-9}
\]

\[
\mu_{nmin} = 54.3 \left( \frac{Y}{300} \right)^{-0.57} \quad \text{B-10}
\]

\[
\Delta \mu_n = 1252 \left( \frac{Y}{300} \right)^{-2.33} \quad \text{B-11}
\]

\[
\Delta \mu_p = 407 \left( \frac{Y}{300} \right)^{-2.33} \quad \text{B-12}
\]

\[
N_{nref} = 1.432 \times 10^{17} \left( \frac{Y}{300} \right)^{2.456} \quad \text{B-13}
\]

\[
N_{pref} = 2.67 \times 10^{17} \left( \frac{Y}{300} \right)^{2.456} \quad \text{B-14}
\]
B.3 Field Dependent Mobility Model

The field dependent mobilities for $n$ and $p$ respectively are:

$$\mu_n = \frac{\mu_n^D}{\sqrt{1 + 1.54 \cdot 10^{-5} \cdot E}}$$  \hspace{1cm} B-15

$$\mu_p = \frac{\mu_p^D}{\sqrt{1 + 5.35 \cdot 10^{-5} \cdot E}}$$  \hspace{1cm} B-16
B.4 Sheet Resistance Calculation

After solving the Poisson equation, the sheet resistance for each semiconductor layer is estimated using:

$$R_{sh} = \frac{\int_{x_{left}}^{x_{right}} dx}{q \mu_n \cdot n + q \mu_p \cdot p}$$

$x_{left}$ and $x_{right}$ are determined by the p-n junction locations and the semiconductor material boundaries.
Threshold Voltage Calculation

B.5 Threshold Voltage Calculation

Threshold voltage calculation is based on the calculated sheet resistance. In MOS mode (1D vt extraction), the solver will calculate threshold voltage automatically. First, the conductance of the channel region will be calculated for each gate voltage applied. If an NMOSFET structure is assumed, then:

\[ g(V_g) = \int_{O}^{x_{inv}} \frac{q \mu_n}{n} dx \]

\( O \) corresponds to the oxide-silicon interface and \( x_{inv} \) is the boundary of the inversion layer. Threshold voltage will be determined using the \( g(V_g) \) curve as an intersection with the \( V_g \) axis of the straight line drawn through two points on the \( g(V_g) \) curve, corresponding to the maximum slope region shown below.

![Diagram showing the calculation of threshold voltage](chart.png)
B.5.1 Breakdown Voltage Calculation

Breakdown voltage calculation is based on estimation of ionization integrals for electrons and holes. Breakdown is determined by the condition that one of the integrals is greater than 1. The ionization rates are calculated using the following equations (See the Selberherr model in the Atlas User’s Manual):

\[
\alpha_n = AN \cdot \exp \left[ \frac{BN}{E} \right]^{BETAN} \\
\alpha_p = AP \cdot \exp \left[ \frac{BP}{E} \right]^{BETAP}
\]

where:

- \( AN = AN1 \) if \( E < EGRAN = AN2 \) if \( E > EGRAN \)
- \( AP = AP1 \) if \( E < EGRAN = AP2 \) if \( E > EGRAN \)
- \( BN = BN1 \) if \( E < EGRAN = BN2 \) if \( E > EGRAN \)
- \( BP = BP1 \) if \( E < EGRAN = BP2 \) if \( E > EGRAN \)

The values of the parameters \( AN1, AN2, AP1, AP2, BN1, BN2, BP1, BP2, BETAN, BETAP, EGRAN \) are user-definable (through the extract command or pop-up menu). Their default values are:

- \( AN1=7.03e5 \) cm\(^{-1}\)
- \( AN2=7.03e5 \) cm\(^{-1}\)
- \( BN1=1.231e6 \) V/cm
- \( BN2=1.231e6 \) V/cm
- \( AP1=6.71e5 \) cm\(^{-1}\)
- \( AP2=1.582e6 \) cm\(^{-1}\)
- \( BP1=1.693e6 \) V/cm
- \( BP2=2.036e6 \) V/cm
- \( BETAN=1.0 \) (unitless)
- \( BETAP=1.0 \) (unitless)
- \( EGRAN=4e5 \) V/cm
## Index

<table>
<thead>
<tr>
<th>A</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adaptive Simulated Annealing</td>
<td>126</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Window</td>
<td>21–46</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>13–20</td>
</tr>
<tr>
<td>File Menu</td>
<td>80–81</td>
</tr>
<tr>
<td>Help Menu</td>
<td>47–54</td>
</tr>
<tr>
<td>Plot Menu</td>
<td>70–80</td>
</tr>
<tr>
<td>Production Menu</td>
<td>55–69</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>149</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concentration Dependent Mobility</td>
<td>150</td>
</tr>
<tr>
<td>Curve Shifting</td>
<td>27</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Dependent Mobility Model</td>
<td>147</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>K</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Styles</td>
<td>92</td>
</tr>
<tr>
<td>Positioning Key Boxes</td>
<td>91</td>
</tr>
<tr>
<td>Types</td>
<td>91</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh</td>
<td>93</td>
</tr>
<tr>
<td>Mesh Plot Display in 2D</td>
<td>100</td>
</tr>
<tr>
<td>3D</td>
<td>95–96</td>
</tr>
<tr>
<td>Contours</td>
<td>99</td>
</tr>
<tr>
<td>Junction</td>
<td>98–99</td>
</tr>
<tr>
<td>Light Rays</td>
<td>101</td>
</tr>
<tr>
<td>Lines</td>
<td>94</td>
</tr>
<tr>
<td>Regions</td>
<td>97–98</td>
</tr>
<tr>
<td>Vectors</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controlling</td>
<td>119</td>
</tr>
<tr>
<td>Creating</td>
<td>119</td>
</tr>
<tr>
<td>Cutlines</td>
<td>120</td>
</tr>
<tr>
<td>Displaying</td>
<td>119</td>
</tr>
<tr>
<td>Identifying Data</td>
<td>120</td>
</tr>
<tr>
<td>Level Names</td>
<td>120</td>
</tr>
<tr>
<td>Preferences</td>
<td>120</td>
</tr>
<tr>
<td>Splitting</td>
<td>119</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Models</td>
<td>145</td>
</tr>
<tr>
<td>Plot Control</td>
<td>90</td>
</tr>
<tr>
<td>3D</td>
<td>90</td>
</tr>
<tr>
<td>Key Commands</td>
<td>90</td>
</tr>
<tr>
<td>Pointer Zooming</td>
<td>82</td>
</tr>
<tr>
<td>Selecting</td>
<td>82</td>
</tr>
<tr>
<td>TonyPlot Command Stream</td>
<td>83–89</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSM Display</td>
<td>106</td>
</tr>
<tr>
<td>1D Graphs</td>
<td>107</td>
</tr>
<tr>
<td>2D Contours</td>
<td>107–108</td>
</tr>
<tr>
<td>3D Surfaces</td>
<td>108</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Files</td>
<td>116</td>
</tr>
<tr>
<td>Creating</td>
<td>116–117</td>
</tr>
<tr>
<td>Syntax</td>
<td>117</td>
</tr>
<tr>
<td>Sheet Resistance Calculation</td>
<td>148</td>
</tr>
<tr>
<td>Shift Curve</td>
<td>27</td>
</tr>
<tr>
<td>Starting TonyPlot</td>
<td>11–12</td>
</tr>
<tr>
<td>Command Line Options</td>
<td>12</td>
</tr>
<tr>
<td>Examples</td>
<td>12</td>
</tr>
<tr>
<td>Statistics Display</td>
<td>111</td>
</tr>
<tr>
<td>Box Plot</td>
<td>111</td>
</tr>
<tr>
<td>Histograms</td>
<td>110</td>
</tr>
<tr>
<td>Pie Charts</td>
<td>110</td>
</tr>
<tr>
<td>Scatter Plot</td>
<td>110</td>
</tr>
<tr>
<td>Sunray Plot</td>
<td>111</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold Voltage Calculation</td>
<td>149</td>
</tr>
<tr>
<td>TonyPlot</td>
<td></td>
</tr>
<tr>
<td>Base Window</td>
<td>13–81</td>
</tr>
</tbody>
</table>
## Index

**Data** .................................................................................. 7  
**Help** ................................................................................. 8, 80–81  
**Keys** .................................................................................. 91–92  
**Overlays** ............................................................................ 119–120  
**Plot Control** ...................................................................... 82–90  
**Plot Display** ...................................................................... 93–111  
**Production Mode** ............................................................ 122  
**Set Files** ............................................................................. 116–117  
**Standard Controls** ............................................................ 9  
**Starting** ............................................................................... 11  
**Terminology** ...................................................................... 8  
**User Data Files** ................................................................ 113–115  

**TPCS**  
**Commands** ..................................................................... 133–143  
**Finishing** .......................................................................... 84  
**Help** ................................................................................... 84  
**Supported Statements** ....................................................... 84–89  
**Syntax** ................................................................................ 83  

**U**  
**User Data Files**  
  **Creating** .......................................................................... 113  
  **Examples** ......................................................................... 114–115  
  **Format** ............................................................................... 113–114  
  **Loading** ............................................................................. 113  

**V**  
**VWF Production Menu**  
  **ASA Setup** ...................................................................... 80  
  **Calibration** ....................................................................... 72  
  **Experimental Results** ....................................................... 78  
  **Failure Analysis** ............................................................... 71  
  **Input distributions** ............................................................ 76  
  **Input Parameter Ranges** ................................................... 75  
  **Interactive** ........................................................................ 70  
  **Optimizer Setup** .............................................................. 79  
  **Production Mode** ............................................................ 74  
  **SPC limits** ......................................................................... 77  
  **Synthesis** .......................................................................... 73  
  **Yield Analysis** ................................................................. 74  

**VWF Production Mode**  
  **ASA Setup** ...................................................................... 131  
  **Calibration** ....................................................................... 125  
  **Dialog Box** ...................................................................... 123  
  **Enabling** .......................................................................... 122  
  **Experimental Results** ....................................................... 129  
  **Failure Analysis** ............................................................... 124  
  **Input Distributions** ............................................................ 128  
  **Input Parameter Ranges** ................................................... 127  
  **Input Sliders** .................................................................... 124  
  **Interactive RSM Control** ................................................... 123  
  **Optimizer Setup** .............................................................. 130  
  **Outline** ............................................................................. 122  
  **SPC Limits** ....................................................................... 128–129  
  **Synthesis** .......................................................................... 126  
  **Yield Analysis** ................................................................. 126–127  

**X**  
**X-Y Graph Display** .......................................................... 102–104  
  **Cartesian Graphs** ............................................................. 103  
  **Polar Charts** .................................................................... 103  
  **Smith Charts** .................................................................... 104  

---

_SILVACO_